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Chapter 1: Overview 

Over the last three decades, the biggest challenge of IT departments in many organizations was 
moving to a paperless work environment. Seemingly, there was tremendous success in this 
regard. Today, most transactions in the business world are performed electronically: 

♦ Documents are written using word processing programs. 

♦ Messages are sent via email. 

♦ Inventories and purchases are tracked using Enterprise Resource Planning (ERP) systems. 

♦ Medical information is stored in Electronic Medical Record (EMR) systems. 

Although these transactions are performed in a paperless environment, organizations have still 
not managed to find an easy way to get rid of the paper used for data authentication (signing 
the authenticity of the data). Today, although organizations have invested large amounts of 
funds and other resources in creating paperless environments, their workers are still printing 
every transaction, signing it, and saving the printed copy. These organizations require a digital 
method for data authentication. 

By moving to a viable electronic data authentication system, organizations can reduce their 
printing, archiving, shipping, and handling costs. In addition, better and more competitive 
customer service can often be provided. 

Requirements for Data Authentication Systems 

A viable data authentication system must meet the following specifications: 

♦ Security – The system must ensure that no one other than the data creator can tamper with 
or change the data in any way. 

♦ Third-party validation – The system must enable any third party to validate the 
authenticity of the data. If a dispute arises between the parties (the data creator and 
recipient), any third party must be able to validate the data authenticity in order to settle 
the dispute. 

♦ System independence – Data authentication must be independent of the system that created 
the data. Users must be able to validate the authenticity of the data using a known standard 
that is independent of any specific system. 

♦ Validation over time – Users must be able to validate data authenticity at any point in time. 
Authenticity cannot expire at any point. 

Currently, the only data authentication method known to support all of these requirements is 
the Public Key Infrastructure (PKI) method of authenticating data, simply called “digital 
signatures”. 
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Introduction to CoSign 

CoSign is a PKI-based, off-the-shelf digital-signature solution that can be integrated with a 
wide range of applications. In this way, CoSign enables organizations to embed digital 
signatures in various documents, forms, and transactions. CoSign is a turnkey, hardware-based 
solution that is easily and quickly deployed in the network and provides cost-effective digital-
signature capabilities for the organization.  

CoSign includes all the components needed for PKI-based digital-signature deployment. You 
do not need to install any other device or integrate any other component for the system to 
work.  

CoSign integrates with leading user management systems, including Microsoft Active 
Directory, Novell NDS, and LDAP based environments. This integration ensures no overhead 
in managing the digital-signature system and signature credentials (i.e., the private keys that 
are needed in a PKI environment), solving one of the main problems of legacy digital-
signature systems. System managers, network managers, and end-users can continue to use the 
IT infrastructure in the same manner as before CoSign was installed. 

CoSign stores the signature credentials in a secure server, ensuring that the signer has 
exclusive access to his or her signature credentials, while still maintaining a centrally managed 
solution. This is necessary in order to fulfill the security requirement of the data authentication 
system. 

An increasing number of applications can work with CoSign as their digital-signature layer 
without needing any further integration, including: 

♦ Microsoft Office 2007 (Word, Excel, and PowerPoint) 

♦ Microsoft Office XP/2003 (Word, Excel, and PowerPoint) 

♦ Microsoft Word/Excel 2000 

♦ Microsoft InfoPath 

♦ Adobe Acrobat 

♦ Word Perfect 

♦ Microsoft Outlook and Outlook Express 

♦ Adobe Server forms (for signing web forms) 

♦ AutoCAD 

♦ Lotus Notes 

♦ Microsoft BizTalk 

♦ FileNet eForms 

♦ Verity Liquid Office 

♦ ERP systems (e.g., SAP) 

♦ Crystal Reports 
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♦ OpenOffice (Writer, Calc, etc.) 

♦ StarOffice (Writer, Calc, etc.) 

♦ Web applications 

♦ Any application that has a print option can use CoSign to generate a PDF file and sign it 

For information on using CoSign with other applications, contact ARX technical support. 

CoSign also leads the development of Signature API (SAPI), an API that enables application 
developers to easily integrate with CoSign. For more information about integrating with 
CoSign, refer to the CoSign Programmer Guide (SAPI). 

CoSign includes the following components: 

♦ The CoSign appliance hardware and software, connected to the organization’s network. 
For more information, refer to the chapter Installing CoSign in the CoSign Administrator 
Guide. 

♦ The CoSign Client software, installed on the users’ computers. For more information, refer 
to Chapter 2: Deploying the CoSign Client.  

♦ The CoSign Administrative software that includes the CoSign Microsoft Management 
Console (MMC) snap-in, installed on the administrative computer. For more information, 
refer to the chapter Managing the CoSign Installation in the CoSign Administrator Guide. 

CoSign Guides 

CoSign documentation includes three guides: 

♦ CoSign Administrator Guide – Provides all the information necessary for an administrator 
to install and manage the CoSign appliance in the various environments in which CoSign 
can operate. 

♦ CoSign User Guide – Provides all the information necessary for an end user to use CoSign. 
Includes information about special add-ins for various applications such as Microsoft 
Office. 

♦ CoSign Programmer Guide (SAPI) – Provides all the information necessary for a 
developer to interact with CoSign. Three application interfaces (API) are available: 

♦ An interface for C/C++ applications. 

♦ An interface for COM based applications. 

♦ An interface based on Web Services to be used by Application Servers. 
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CoSign Appliance Hardware Models 

There are several available hardware models of the CoSign appliance. The models differ in 
functionality, as follows: 

♦ CoSign Enterprise – The most common CoSign appliance. This rack-mountable box is 
based on a sealed, tamper-response casing. The hardware box is FIPS 140-2 level 3 
validated. 

♦ CoSign SSCD – The CoSign SSCD is very similar to the CoSign Enterprise edition. The 
major difference is that all end users’ private keys are located inside an array of SmartCard 
chips and the RSA signature operation is performed inside a SmartCard. Each user’s key 
can be used only if a dedicated password is provided for accessing the key. Thus, the end 
user’s private key is considered more protected than in the CoSign Enterprise model. 
The CoSign SSCD appliance provides a solution that is compliant with the Common 
Criteria SSCD protection profile (CWA-14169). 

♦ CoSign SMB – CoSign SMB is a digital-signature turnkey solution that meets the needs of 
smaller organizations. It is an easy-to-deploy and easy-to-use digital-signature appliance 
that integrates with leading applications. It enables organizations to embed digital 
signatures that can include a graphical (handwritten) signature.  
The main differences between CoSign Enterprise and CoSign SMB are that CoSign SMB 
has a less secure hardware casing (i.e., CoSign SMB does not include hardware-based 
tamper-evident mechanisms), and CoSign SMB is limited to organizations of no more than 
100 users. 

 

Note: Throughout this guide, the term “CoSign” refers to all hardware models (Enterprise, 
SSCD, and SMB), and the Desktop model, unless otherwise noted. 

Organization of this Guide 

This guide is organized as follows: 

♦ Chapter 1: Overview – Provides an overview and introduction to CoSign. 

♦ Chapter 2: Deploying the CoSign Client – Describes how to install the CoSign client, 
install plug-ins for Microsoft Office, Adobe Acrobat and Tiff, set graphical signatures, use 
CoSign Verifier, and more. 

♦ Chapter 3: Signing Microsoft Office Documents – Describes how to generate and validate 
digital signatures for Microsoft Office applications, and integrate the digital signatures into 
the general application flow. 

♦ Chapter 4: Signing InfoPath Forms – Describes how to generate and validate digital 
signatures for Microsoft InfoPath forms, and integrate the digital signatures into the 
general application flow. 

♦ Chapter 5: Signing Adobe Acrobat Documents – Describes how to sign and validate an 
Adobe Acrobat document using Adobe Acrobat or Adobe Reader, as well as how to certify 
an Acrobat document. 
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♦ Chapter 6: OmniSign – Sign Any Printable Data, Anywhere – Describes how to use 
OmniSign to sign any printable data from any application. 

♦ Chapter 7: The ARFileSign Utility – Describes the arfilesign.exe command line 
utility which can be used to digitally sign any PDF, Tiff, Word/Excel 2007, or Word 2003 
file. 

♦ Chapter 8: Signing WordPerfect Documents – Describes how to generate and validate 
digital signatures using WordPerfect. 

♦ Chapter 9: Signing Outlook Emails – Describes how to generate and validate digital 
signatures using Microsoft Outlook and Microsoft Outlook Express. 

♦ Chapter 10: CoSign Configuration Utility – Describes how the CoSign Configuration 
Utility enables the user to set the configuration of any parameter in any of the CoSign 
client components. 

♦ Chapter 11: Troubleshooting – Offers solutions to various client-related problems you 
may encounter while running the CoSign Client. 

♦ Index – Provides a comprehensive index of the topics discussed in this guide. 
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Chapter 2: Deploying the CoSign Client 

This chapter describes how to: 

♦ Install the CoSign Client. 

♦ Install Plug-ins for Microsoft Office, Adobe Acrobat, and Tiff. 

♦ Use the graphical signature registration application that enables setting a graphical 
signature for users of the organization. 

♦ Use CoSign Verifier to validate digital signatures that were attached to applications such 
as Office using CoSign. 

♦ Use the CoSign Control Panel to enroll a key based on CoSign SSCD. 
 

Note: The installation of CoSign differs slightly depending on whether it is being installed in a 
Microsoft Active Directory environment, Novell NDS environment, LDAP based environment, 
or a Directory Independent environment. These differences are mentioned where applicable. 

Installing the CoSign Client 

CoSign enables the end-user to digitally sign transactions, documents, and other types of data. 
In order to perform these tasks, the CoSign client must be installed. The CoSign client enables 
applications such as Microsoft Word to use CoSign for generating digital signatures. For more 
information on generating signatures in third-party applications, refer to chapters 3-9. 

The CoSign client may be installed on a machine using one of the following operating 
systems: 

♦ Windows 2000 Professional. 

♦ Windows 2000 Server. 

♦ Windows 2000 Advanced Server. 

♦ Windows XP Professional. 

♦ Windows 2003. 

♦ Windows VISTA. 
 

Note: You must have local administrative rights in order to install the CoSign client. 
 

Note: In Novell NDS, LDAP, or Directory Independent environments: If the CoSign internal 
CA is used for generating end user’s certificates, then the ROOT certificate must be manually 
installed on every workstation on which a CoSign client is installed. Refer to Installing the 
ROOT Certificate. 
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CoSign Client Components 

The CoSign Client CD displays a CoSign Client Components Installation screen when the 
CoSign Client CD is put into the CD driver. 

Each CoSign component is based on several .msi files. The .msi files are based on the 
Microsoft Software Installation technology.  

The components include: 

♦ ARX CoSign Client – The standard CoSign client installation without any plug-ins.  

♦ ARX CoSign Admin – Enables administrators to install and manage CoSign. The 
installation and management activities are described in the chapter Installing CoSign and 
the chapter Managing the CoSign Installation in the CoSign Administrator Guide. 

♦ Microsoft Office (Word, Excel, InfoPath) – Three types of plug-ins are 
supported: 

♦ ARX Signature Line Provider – A digital signature plug-in for Office 2007 for 
the .docx and .xlsx file types.  

♦ ARX Legacy Word Add-in – A digital signature plug-in for Word 
2000/XP/2003/2007 and Excel 2000/XP/2003/2007 that enables you to sign .doc and 
.xls files. 

♦ Digital signature support for Microsoft InfoPath forms.  
For more information, refer to Chapter 3: Signing Microsoft Office Documents and 
Chapter 4: Signing InfoPath Forms. 

♦ Adobe Acrobat – A plug-in for using digital signatures in Adobe Acrobat PDF 
documents. For more information refer to Chapter 5: Signing Adobe Acrobat Documents. 

♦ ARX OmniSign Printer – A plug-in for signing any printable data from any 
application. For more information refer to Chapter 6: OmniSign – Sign Any Printable 
Data, Anywhere. 

Installation Pre-requisites 

♦ To perform signatures using Office 2007 upon .docx or .xlsx files, it is mandatory to 
install .NET Framework version 2 or above in the client machine. The client installation 
prompts the end user to automatically install .NET framework 2 if it is not already 
installed. 

♦ To perform signatures upon .docx or .xlsx files using SAPI, it is mandatory to install 
.NET Framework version 3 in the client machine. The installation is not performed 
automatically by the CoSign client installation and should therefore be performed by the 
user.  

♦ If you intend to use the ARX add-in for Microsoft Office, you should include the 
component called "Visual Basic for applications" when installing Microsoft Office. This 
component is included in the Microsoft Office installation by default. 



Deploying the CoSign Client 2 

 9 

Installing the Client Directly from the CD 

To install the CoSign client directly from the CD: 

1. Insert the ARX CoSign CD into the CD drive. The following CoSign Client Components 
Installation screen appears:  

 

Figure 1  CoSign Client Components Installation Screen 

2. Select the components you wish to install, based on the designation of the current 
workstation. Keep in mind the following: 

♦ The ARX CoSign Client component is always selected. 

♦ If the workstation is an administrative workstation, select the ARX CoSign Admin 
component. 

♦ If the workstation is a user workstation, select the applicable components (Office, 
Adobe or OmniSign). 

 
Note: The Office and Adobe components are automatically selected if 
Office or Adobe is installed in the end-user machine. 

 
Note: The OmniSign Printer component installs a new virtual printer in 
the end-user’s machine. 

3. Click Install Now. 

When installation is complete, a √ appears next to each of the installed components. In case of 
a failure, an X appears next to the relevant components and a summary information box 
appears. 
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Alternatively, you can place the contents of the CoSign CD on the network so that end users 
can install the CoSign Client through the network. While this method eliminates the need to 
use the CD for each installation, it does not facilitate automatic installations of the software. 

Uninstalling the CoSign Client 

To uninstall the CoSign client locally: 

1. Open the Start menu and select Programs  ARX CoSign  Uninstall CoSign 
Components. 

2. A confirmation box appears. Click Yes to uninstall. The uninstalling process begins. 

3. When the CoSign Client is uninstalled from the workstation, a message box appears to 
inform you that the system finished uninstalling. Click OK. 

Using the CoSign Control Panel 

Starting from CoSign version 4, all client-based operations are activated through the CoSign 
Control Panel. 

 

Figure 2  CoSign Control Panel 

Some Control Panel options are always active, while others are active depending on the status 
of the CoSign appliance (Installed/Not Installed), the type of CoSign appliance installation 
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(Microsoft Active Directory, Novell NDS, LDAP, or Directory Independent), or whether the 
CoSign client is in stand-alone mode (CoSign Desktop). 

User Actions 

Client Configuration – This option enables the end user to configure the CoSign client 
settings. Refer to Chapter 10: CoSign Configuration Utility for more information. 

Graphical Signatures – This option enables both end users and administrators to manage 
personal graphical signatures. For more information refer to Using the Graphical Signature 
Management Application. 

Change User Password – This option is relevant only in the case of a Directory Independent 
environment. For more information refer to Directory Independent Environment Options. 

OmniSign Settings – This option activates the OmniSign application in configuration mode. 
In this mode the user can setup the appearance and other parameters related to the digital 
signature created using OmniSign. For more information related to OmniSign, refer to Chapter 
6: OmniSign – Sign Any Printable Data, Anywhere. 

Logoff – This option logs off from the session. This option is relevant when CoSign is 
installed in a Directory Independent environment, Novell NDS environment, or any other 
configuration where the user needs to login manually. 

Directory Independent Environment Options 

The following options are relevant only for a Directory Independent environment: 

♦ Client Configuration – see the explanation in User Actions.  

♦ Graphical Signatures – see the explanation in User Actions. 

♦ Change User Password – see the explanation in User Actions. 

♦ OmniSign Settings – see the explanation in User Actions. 

♦ Logoff  – see the explanation in Changing the Password in a Directory Independent 
Environment. 
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Figure 3  CoSign Control Panel – Directory Independent Environment 

Changing the Password in a Directory Independent Environment 

To change your password when CoSign is installed in a Directory Independent 
environment: 

1. Click Change User Password in the CoSign Control Panel (Figure 3). 

The Change Password window appears. 
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Figure 4  Change Password in Directory Independent Environment 

2. Enter your user name. 

3. Enter the old password of the account and the new password of the account. Confirm the 
new password. 

4. Click Change password. 

Designer Actions  

Design InfoPath Templates – This option is relevant for the design of InfoPath templates that 
include CoSign based digital signature. Refer to Chapter 4: Signing InfoPath Forms. 

Administrator Actions  

For administrative operations see the CoSign Administrator Guide. 

CoSign Control Panel Menu Bar 

The User, Designer and Admin options of the CoSign Control Panel menu bar display all the 
options that can be activated from the Control Panel.  
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In addition, the Tools option includes two options. 

 

Figure 5  CoSign Control Panel Menu Bar 

Options – This enables you to configure CoSign Control Panel settings. When you select 
Options from the Tools menu, the following dialog box appears: 

 

Figure 6  CoSign Control Panel Settings 

♦ Show CoSign Control Panel in system tray – Check this option to display the CoSign 
Control panel in the system tray when the Control Panel is activated. 

♦ Personal graphical signatures management – In a regular client installation this option 
is always marked. When this option is checked, the graphical signature application is 
activated in user mode. If the option is unchecked and the CoSign administrative client is 
installed, the graphical signature application will operate in administrative mode. For more 
information, refer to Using the Graphical Signature Management Application. 

Refresh – This option updates the icons in the control panel according to the updated state of 
the CoSign appliance. 

CoSign Control Panel – Tray Item 

The CoSign control panel icon appears in the tray if the option Show CoSign Control Panel 
in the system tray is selected. Right-click the icon to display a popup that enables you to 
perform the following operations: 

♦ Open control panel – Maximizes the control panel. 

♦ Change password – Relevant only for a Directory Independent environment. 

♦ SSCD Key Enrollment – Relevant only for a CoSign SSCD appliance. The Activate Your 
Default Signing Key window appears (Figure 8). 

♦ Logoff – Relevant only if the user is prompted to authenticate in a Directory Independent 
environment, or is configured to prompt for logon. 
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♦ Exit – Closes the CoSign control panel. 

Operating the Control Panel for a CoSign SSCD Appliance  

When CoSign SSCD hardware is used, the procedure of generating a key and a certificate for a 
user is different from the one followed for a regular CoSign appliance. This is due to the 
requirement that only the end user can select the password that protects the user’s key.  
 

Note: Keep in mind that the passwords that protect each of the SSCD-based user’s keys are 
different from the password that protects the user account (Active Directory password, Novell 
NDS password, LDAP password, or Directory Independent password). 

To enable you to sign documents using an SSCD key: 

1. Upon user creation, either during installation or after the installation, the CoSign appliance 
generates a user account and sends you an email notification, directing you to enroll for a 
key. 

 

Figure 7  Request to Enroll 

2. Click Enroll. 

The Activate your Default Signing Key window appears. 
 

Note:  Alternatively, you can enroll by activating the CoSign Control Panel and clicking 
Activate your SSCD key. The Activate Your Default Signing Key window appears.  
In addition, when activating for the first time any application that can potentially sign using 
CoSign, the Activate your Default Signing Key window appears. 
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Figure 8  Activate Your Default Signing Key 

3. In the Activate your Default Signing Key window enter the password that will protect the 
SSCD key, and confirm it. 

When you click OK, the key is generated inside the CoSign SSCD hardware. The CoSign 
appliance may also generate a certificate for you, depending on the certification model. 
You are informed that the key and certificate are ready for use and you can start signing 
documents. 

4. Whenever you use an SSCD key for a digital signature operation, you are prompted to 
enter a password. 

 

Figure 9  Password Entry When Signing with an SSCD Key 

Updating SSCD Keys 

To update SSCD keys: 

1. Click Update your SSCD keys in the CoSign Control Panel.  

The Change password window appears. 
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Figure 10  Change Password – Updating SSCD Keys 

2. Enter a key in the Key’s ID field. 

3. You can perform the following on the selected SSCD key: 

♦ Change Password – Enter the old password and the new password, and confirm the 
new password. 

♦ Delete Key – Click Delete to delete the selected SSCD key. If you wish to sign 
documents, you must enroll for a new key.  

 
Note: Deletion of an SSCD key does not automatically delete its matching 
certificate. 

Using the Graphical Signature Management Application 

The Graphical Signature Management application enables you to view all your graphical 
signatures and create a new graphical signature. This graphical signature can be attached to all 
Microsoft Word, Excel, InfoPath, and Adobe Acrobat documents that you sign.  

The Graphical Signature application is automatically installed together with the ARX CoSign 
Client component.  
The Signature application can be used in either of two modes of operation: 

♦ Administrative Mode – An administrator station is used for registering the user’s 
graphical image. The user will supply his/her identity and password after which the user 
can register or view his/her own graphical images. 

♦ User Mode – The user can register or view his/her own graphical images. 
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Installing the Signature Registration Device  

The CoSign appliance is supplied with a graphical signature registration device. 

There are several types of signature capture pads you can use: 

♦ Signature capture pads produced by Topaz Systems (http://www.topazsystems.com). Two 
models are available: 

♦ SigLite LCD 1x5 USB – This model includes an LCD capture device. The entered 
graphical signature appears on the LCD screen. 

♦ SigLite 1x5 USB – This model does not include an LCD capture device. 

 

Figure 11  SigLite LCD 1x5 USB 

♦ Signature capture pads produced by Interlink Electronics 
(http://www.interlinkelectronics.com). Two models are available: 

♦ ePad-ink - This model includes an LCD capture device. The entered graphical 
signature appears on the LCD screen. 

♦ ePad – This model does not include an LCD capture device. 
Note that the signature registration devices can be installed only on machines on which 
the CoSign admin client is installed. 

http://www.topazsystems.com/
http://www.interlinkelectronics.com/
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Figure 12  ePad-ink  

 

Figure 13  ePad  

To install the graphical signature registration device: 

♦ Connect the signature capture pad to the USB port on the workstation. The pad’s drivers 
are automatically installed.  

 

Managing Graphical Signatures 

To manage your graphical signatures: 

1. Open the Start menu and select Programs  ARX CoSign  CoSign Control Panel. The 
CoSign Control Panel appears. 

2. If the signature application is operating in administrative mode and you would like it to 
operate in user mode, perform the following:  

♦ Select Options from the Tools menu in the Control Panel. The Control Panel Settings 
window appears (Figure 6).  

♦ Check the Personal graphical signatures management option. 
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3. In the Control Panel click Graphical Signature. The ARX Graphical Signature Viewer 
dialog box appears, for managing your graphical signatures. 

 

 
Note: This dialog box can also be activated from a SAPI based application such 
as OmniSign for the purpose of selecting a graphical image to incorporate into 
the digital signature. When selecting, the user can either add a new graphical 
image or select a temporary graphical signature (One-time Signature). 

 

Figure 14  ARX Graphical Signatures Viewer Dialog Box  

4. The lower part of the dialog box contains a list of all the user’s graphical signatures. For 
each item in the list you can view its corresponding graphical image. 

5. You can activate the following buttons: 

♦ New – Creates a new graphical image. Images can be loaded either from a file or from 
the signature pad. 

♦ Delete – Deletes an existing graphical image. The currently selected graphical image 
is deleted. 

♦ Edit – A new graphical image replaces the existing one. 

♦ Update Acrobat – The graphical image defines a new appearance with the name ARX 
Signature - <graphical signature label>. This appearance, which includes the 
graphical image, can be selected in every signature operation (refer to Chapter 5: 
Signing Adobe Acrobat Documents). 
This option is enabled only when operating in user mode and not in administrative 
mode. 
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♦ One-time Signature – This option is mainly relevant to cases where the dialog box is 
invoked from applications such as OmniSign. In this case, you can add a graphical 
image that will be used only for the specific digital signature operation. 
This option invokes the same operation as the Capture Signature option described in 
the next step. The new graphical image is deleted when this dialog box is closed. 

6. If you click either New or Edit, the Create new graphical signature dialog box appears.  

 

Figure 15  Create new graphical signature Dialog Box 

The display area displays the current graphical image.  

The following options are available: 

♦ Load Picture – Use this option to load an image file into CoSign. The possible types 
of images are: monochrome bmp, multicolor bmp, or jpg. 

♦ Capture Signature – The following signature capturing options appear if you specify 
manual in the Capturing Device ID parameter in the SAPI section. For each 
option, a dialog box appears, directing you to enter the graphical signature. Click OK 
in the dialog box to load the graphical signature you create into CoSign 

♦ Using a pad – Use this option when it is required to enter the graphical image 
using a signature registration pad. Use the pad as described in Installing the 
Signature Registration Device. If you are using a signature registration device with 
no LCD display, you will be able to see the signature only on the PC screen, while 
editing it. 
If you are using a signature registration device with an LCD display, you will be 
able to see the signature both on the device and on the PC screen while editing it. 

♦ Using a mouse or Tablet PC – Use a Tablet PC and a pen or a regular PC mouse 
to enter a new graphical image. Any movement of the mouse or pen in the tablet 
PC is drawn in the Capture Signature window that appears. Click Clear to re-start 
the capture. 
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Figure 16  Capture Signature Dialog Box – Using a Mouse or a Tablet PC 

♦ Using a script font – Specify a script font and an input text for generating a 
graphical image. In the Capture Signature window that appears, enter the desired 
text and click Font to select a script font. The displayed text is the new graphical 
image. 

 

Figure 17  Capture Signature Dialog Box – Using a Script Font 

♦ Select Color – In the case of a monochrome bmp image, you can select the color of 
the graphical image. If you click this button, a standard Microsoft color selection 
window appears, enabling you to select the desired color of the graphical image. 

 

Note: Graphical signatures are stored in the CoSign’s users database as graphical objects. 
 

Note: The first time you register a signature you must have local administrative rights. 
Afterwards, any user can register a signature. 

Installing the ROOT Certificate for Validation Purposes 

This procedure for installing the ROOT certificate is not required in the following cases only: 

♦ CoSign is installed in a configuration where an external CA is used (if the users’ 
certificates are provided by a World Wide verifiable CA, the ROOT certificate is already 
installed in the verifier’s PC). 
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♦ The organization is deploying a CoSign Verifier home page (refer to Using CoSign 
Verifier for Validation Purposes). The end user already uses these pages to install the 
organization ROOT certificate. 

The sections below describe how to install the ROOT certificate. 

An end user in an organization without CoSign who wishes to validate signatures that were 
originated by CoSign, must obtain the ROOT certificate of the organization that signed the 
document. The ROOT certificate is a .cer file that is installed on the end user’s workstation 
either automatically or manually by the end user.  
 

Note: If CoSign is installed as a subordinate CA, you must make sure that the ROOT CA 
certificate is installed in the end user’s machine. 
 

Note: Alternatively you can use the client configuration utility to download the CoSign ROOT 
certificate to a file. Use the Download CoSign CA Certificate option in the CA menu (refer 
to CoSign Configuration Utility Menus). 

Installing the ROOT Certificate 

The ROOT certificate needs to be installed on the end user’s workstation to enable proper 
validation of signatures. There are two methods for installing the ROOT certificate: 

♦ Direct installation. 

♦ Adding the ROOT certificate to a trusted CA list in the Active Directory of the domain of 
the organization that does not have CoSign. 

Direct Installation 

To install the ROOT certificate: 

1. On the end user’s workstation, double-click the .cer file and follow the instructions in the 
wizard that appears.   

2. When the Certificate dialog box appears, click Install Certificate (Figure 18). 
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Figure 18  Certificate Dialog Box 

3. Click Yes in the Root Certificate Store dialog box. 

 

Figure 19  Root Certificate Store Dialog Box 

The ROOT CA Certificate is installed on your PC, enabling you to validate signatures. 

For more information on how to automatically install the ROOT certificate, see the CoSign 
Administrator Guide. 
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Using CoSign Verifier for Validation Purposes 

If you are not using CoSign, you can still validate digital signatures that were attached to 
Microsoft Office documents using CoSign. To do so, you need to install the CoSign 
Verifier. 

The CoSign Verifier is installed via a web interface. It can be installed either by connecting to 
ARX’s web page http://www.arx.com/support/downloads.php, or by connecting to the 
organization’s web page, which you can set up as described in Installing the CoSign Verifier. 

Installation of the CoSign Verifier provides the following functionality: 

♦ Installation of an Office verifier capable of verifying Word and Excel digital signatures. 
For more information on verifying Word or Excel documents, refer to Chapter 3: Signing 
Microsoft Office Documents. 

♦ Installation of an organizational ROOT certificate. 

♦ Automatically setting Adobe 6, 7 and 8 configuration parameters to enable signature 
verification without having the end user manually set any parameters. For more 
information refer to Chapter 5: Signing Adobe Acrobat Documents.  

 
Note: If you install the CoSign verifier from the www.arx.com site, the ROOT of ARX is 
installed. It is therefore recommended to deploy the web-based installation as part of the 
organization web site, and use the organization ROOT certificate. The deployment is 
described in the CoSign Administrator Guide. 

 
Note: If a World Wide verifiable external CA is used, there is no need to install the ROOT 
certificate since it is already installed in the verifier’s PC. 

 
 

Note: Validating a signature in Adobe Acrobat 6/7/8 does not require a plug-in, and is based 
on the internal comprehensive digital signature functionality of Adobe Acrobat 6/7/8. 

The following sections provide information on how to deploy the CoSign Verifier in the 
customer web site, and how to install the CoSign Verifier from the web site.  

Installing the CoSign Verifier 

To install the CoSign Verifier: 

1. Click the CoSign Verifier deployment web page. For example, if you choose to download 
the CoSign Verifier from the ARX web site, click 
http://www.arx.com/support/downloads.php.  

2. Acknowledge the verifier installation by right-clicking the upper section of the web page 
and activating the Install Active X option. 

The following window appears: 

 

http://www.arx.com/support/downloads.php
http://www.arx.com/
http://www.arx.com/support/downloads.php
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3. Click Install to continue with the installation. 

The following web pages indicate the progress of the CoSign Verifier installation. 
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Note: If you use VISTA in user mode, you must turn off the Enable Protected Mode flag in 
the Security tab of the Internet Options dialog. You can turn the flag back on after installation 
is complete. 
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Chapter 3: Signing Microsoft Office Documents 

CoSign enables generating and validating digital signatures for Microsoft Office applications, 
and integrating the digital signatures into the general application flow. CoSign supports 
integration with the following applications: 

♦ Office 2007 documents – Refer to Signing Office 2007 Documents – New Document Style. 

♦ Word 2000, Word XP and Word 2003 – Refer to Signing Word and Excel Documents – 
Office 2000/XP/2003 Style. 

♦ Excel 2000, Excel XP, Excel 2003 – Refer to Signing Word and Excel Documents – Office 
2000/XP/2003 Style. 

♦ PowerPoint XP, PowerPoint 2003 – Refer to Signing PowerPoint XP/2003 Documents. 

♦ InfoPath 2003 – Refer to Chapter 4: Signing InfoPath Forms. 

Signing Office 2007 Documents – New Document Style 

CoSign enables you to add digital signatures, as well as graphical signatures, to .docx and 
.xlsx Office 2007 documents using a special plug-in called ARX Signature Line Provider. To 
enable the plug-in, you must install the ARX CoSign Client and ARX’s Microsoft 
Office (Word, Excel, InfoPath) client components. For information on installing 
these components, refer to Installing the CoSign Client. 

The signing process and the configuration of its various options are carried out using the ARX 
Office Signatures Line Provider. This provider fits into the signature line provider concept in 
Office 2007.  

The basic signing process consists of placing signature place-holders (or signature fields) in 
the desired locations in the document, and signing each field. After signing, you can validate 
the signatures. Validation assures you that the document was not modified after it was signed 
and that a trusted CA approved the signers’ certificates. 

You can also activate the ARX Legacy Word Add-in plug-in on pre-2007 .doc or .xls files 
when using Office 2007. For more information refer to Signing Word and Excel Documents – 
Office 2000/XP/2003 Style. 

Adding Signature Fields in Office 2007 

Use the Insert tab’s special Signature Line option to add a new signature field (see 
Figure 20). Click ARX CoSign Signatures Add-in for Office. 
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Figure 20  Selecting the ARX CoSign Signatures Add-in for Office 

A new signature field is generated and embedded inside the Office 2007 document. 

 

Figure 21  Creating a New Signature Field in an Office 2007 Document 

You can perform several operations on this field using the right mouse click, as shown in 
Figure 22. 

 

Figure 22  Signature Field Right-Click Options in Office 2007 

The following two operations are relevant to an empty signature field: 

♦ Sign – Performs the digital signature upon the empty signature field. Refer to Signing 
Empty Signature Fields in Office 2007 for a full description of the digital signature 
operation. 
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♦ Signature Setup – Refer to Configuring Signature Settings in Office 2007.  

All other operations in the popup menu are applicable to the empty signature field object and 
are standard Office 2007 operations upon displayable objects. 

Configuring Signature Settings in Office 2007 

The following sections describe how to configure signature settings in Office 2007. 

CoSign Signature Setup in Office 2007 – General Settings 

When you select Signature Setup from the right-click menu of a signature field (see 
Figure 22), the CoSign Signature Setup dialog box appears, with the Settings tab displayed. 

 

Figure 23  CoSign Signature Setup in Office 2007 – Settings Tab 

This dialog box enables you to define several parameters of the signature field. Some of these 
parameters will be displayed in the signature field and others are used during future signature 
operation. The parameters include: 

♦ Suggested signer – The name of the person who is required to sign this signature field. 
This parameter is displayed as part of an empty signature block. 

♦ Suggested signer’s title –The role of the person who is required to sign this signature 
field. This parameter is displayed as part of an empty signature block. 

♦ Suggested signer’s e-mail address –The email address of the person required to sign 
this signature field. 

♦ Instructions to the signer – The text displayed to the signer during the Sign operation. 

♦ Allow the signer to add reason in the Sign dialog – If this option is selected, the signer 
will be able to add a reason. If you wish this reason to display in the signature field, check 
the Show Reason field in the Advanced tab. 
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Note: Some of the parameters in the Settings tab can be used to enable SAPI to locate a 
certain signature, thus providing the ability to perform digital signatures through SAPI. 

 

 
Note: If you want the CoSign Signature Setup dialog box to appear upon creation of each 
signature field, refer to Setting Microsoft Office Configuration. 

CoSign Signature Setup in Office 2007 – Advanced Settings 

 

Figure 24  CoSign Signature Setup in Office 2007 – Advanced tab 

The Advanced tab of the CoSign Signature Setup dialog box includes the following 
parameters: 

♦ Date and Time Format – Set the displayed format of the signature date and time. 

♦ Show Graphical Image – Specify whether to display a graphical image as part of the 
digital signature. 

♦ Show Date and time – Specify whether to display date and time as part of the digital 
signature. 

♦ Show Reason – Specify whether to display the reason for signing as part of the digital 
signature. 

♦ Show Signed by – Specify whether to display the name of the signer. 

Signing Empty Signature Fields in Office 2007 

You can sign the content of an Office 2007 document by right-clicking an empty signature 
field and selecting Sign from the popup menu. After performing the Sign operation, nothing 
can be changed in the document except that other users can sign other empty fields inside the 
document. 
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To sign the content of an Office 2007 document:  

1. Right-click an empty signature field and select Sign from the popup menu. 

If you have more than one certificate or more than one graphical image, or are required to 
enter a reason for the signature, the Sign with CoSign dialog box appears. 

2. If the Sign with CoSign dialog box appears, fill in the following fields and then click Sign. 

 

Figure 25  Signing with CoSign in Office 2007 

The dialog box may contain some or all of the following sections: 

♦ Select Image – Clicking this button enables changing the graphical signature that will be 
embedded inside the digital signature. The display area of the window shows the current 
display of the digital signature. 

♦ Change – Clicking this button enables you to select the certificate to be used as part of the 
digital signature operation. 

♦ Reason for signing this document – If entering a reason is required, select a reason from 
the predefined list or use a specific reason for this signature operation.  

♦ Additional information – This link directs the user to the ARX web site for more 
information. 

A digital signature operation is performed using the CoSign appliance based on parameters that 
were defined in the Sign with CoSign dialog box (see Figure 25) and the CoSign Signature 
Setup dialog box (Figure 23) 

The following figure shows a sample output of the digital signature operation. 
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Figure 26  Sample Digital Signature in Office 2007 

In this example, the top right of the digital signature includes the signature date. The center of 
the graphical signature includes the selected graphical image. If a graphical image was not 
selected, the signer’s name is displayed in a special script font. The reason is displayed beneath 
the signature line, as well as the signer’s name if an image was selected. 

The following figure shows a not validated digital signature. 

 

Figure 27  Sample Invalid Digital Signature in Office 2007 
 

 
Note: It is possible to generate an invisible digital signature. Refer to the SAPI 
documentation for information on how to generate an invisible digital signature. 

Validating and Viewing Digital Signatures in Office 2007 

In an Office 2007 document (.docx or .xlsx file), the visual display of the digital signature 
indicates the validity of the digital signature. If an existing digital signature is invalid, it will be 
indicated in the document. 

The following options are available when you right-click a signed digital signature field: 
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Figure 28  List of Digital Signatures in Office 2007 

♦ Signature Details – Displays information related to the digital signature and the signer’s 
certificate, as shown in Figure 29. 

 

Figure 29  CoSign Signature Details in Office 2007 – Signature tab 

♦ Signature Setup – Displays signature setup without the ability to modify the values. The 
fields you can view are described in Configuring Signature Settings in Office 2007. 

♦ Remove Signature – Enables the user to remove the signature. After this operation is 
acknowledged, the empty signature field is displayed. 

 

 
Note: The option Sign Again is not relevant for the ARX Signature Line Provider. 

Digital signatures are also listed in a special list of digital signatures that appears to the right of 
the document. To display the digital signatures list, either select the Prepare/View signatures 
option from the main icon of Office 2007, or select the digital signature seal indication in the 
lower left side of the Office window. 
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The digital signature seal indication appears only if there is a signature inside 
the document.  

In the list you can see all unsigned signature fields and existing digital signatures of the 
document. The right-click options available in the list are the same as those available by right-
clicking a digital signature or empty signature field inside the document. 

Validating Office 2007 Signatures 

The following sections describe how a user who is not using CoSign can validate graphical 
signatures that were attached using CoSign in Office 2007. The digital signatures can be 
validated without having to install ARX Signature Line Provider.  

Validating Graphical Signatures in Word Documents Without Using the ARX Signature Line 
Provider 

Using ARX Signature Line Provider for signing documents does not require installing any 
plug-in for verifying the documents. This is useful if you receive documents from a company 
or organization that uses CoSign internally.  
If the signer’s certificate was created by a WorldWide verifiable CA, you need not perform 
any action prior to the validation process. 

To validate signatures: 

1. Obtain the organization’s ROOT CA Certificate (.cer file) from a reliable representative 
of the organization using CoSign. 

2. Install the organization’s ROOT CA Certificate (refer to Installing the ROOT Certificate). 
Alternatively, install the organization’s ROOT CA Certificate using the web-based ARX 
verifier software. 

 
Note: If an external CA is used, or the CoSign certificate is based on a WorldWide 
verifiable CA, there is no need to install the ROOT certificate. 

3. Validate the signature (refer to Validating Signatures).  

Note: Although you are able to view the digital signature, you cannot activate the Signature 
Settings and Signature Details options. Microsoft Office will validate the digital signature 
and display the valid/invalid image according to the validity of the digital signature. 

ARX Office 2007 – CoSign Signatures Toolbar (Ribbon) 

The ARX Office 2007 Signature Line Provider includes a Toolbar (Ribbon) that provides the 
following functionality: 

♦ Sign – Performs a “One Touch Signing” operation. This option both creates a new 
signature field in the mouse location and performs a signature operation upon the new 
field. Refer to Adding Signature Fields in Office 2007 and Signing Empty Signature Fields 
in Office 2007. 
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♦ Add Signature Field – Creates a new signature field in the mouse location. Refer to 
Adding Signature Fields in Office 2007. 

♦ Help – Displays the CoSign help module. This option is similar to selecting Help in the 
ARX Legacy Add-in. 

♦ About – Displays the CoSign Signature Line Provide About window. The window lists the 
current version of the ARX Signature Line Provider and some general ARX information. 

 

Figure 30  ARX Office 2007 Signature Line Provider Toolbar (Ribbon) 

Signing Word and Excel Documents – Office 2000/XP/2003 Style 

CoSign enables you to add digital signatures, as well as graphical signatures, to Word and 
Excel documents in Office 2000, Office XP, Office 2003 and Office 2007, using the ARX 
Legacy Word Add-in plug-in. To enable the plug-in, you must install the ARX CoSign 
Client and ARX's Microsoft Office (Word, Excel, InfoPath) client components. 
For information on installing these components, refer to Installing the CoSign Client. 
 

Note: Starting from CoSign 4.4, you can use the ARX Legacy Word Add-in and ARX Legacy 
Excel Add-in also for .docx and .xlsx files, in addition to.doc  and .xls files. 

Overview  

The signing process and the configuration of its various options are carried out using the ARX 
Legacy Word Add-in toolbar and the signatures’ right-click menu.  

The basic signing process consists of placing signature place-holders (or signature fields) in 
the desired locations in the document, and signing each field. After signing, you can validate 
the signatures. Validation assures you that the document was not modified after it was signed 
and that a trusted CA approved the signers’ certificates. 

During the signing phase, entering Design mode provides the options of changing the size, 
location, and layout of signature fields, as well as deleting signature fields from the document. 

You can optionally create a chronological dependency between signatures in a document. In 
Independent mode, the order of signing is not important. In Dependent mode, an attempt to re-
sign a signature invalidates all the digital signatures created after that signature.  

CoSign supports two types of signatures: content-based signatures, which sign the textual and 
other visible content of a document, and file-based signatures, which sign the entire file. In 
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Word, both signature types are supported. In Excel, only content-based signatures are 
supported. 

The following sections describe the ARX Legacy Word Add-in pull-down menu and toolbar, 
followed by a detailed step-by-step explanation of the signing process, including sections with 
detailed explanations of the various options and dialog boxes. 

It is also possible to use the ARX Legacy Word Add-in in Office 2007 upon Word 2003 
documents. To do so, activate the Add-Ins tab in Word 2007. Both the ARX Legacy Word 
Add-in pull-down menu and its toolbar will appear. 

ARX Legacy Word Add-in Pull-down Menu 

As of CoSign version 4.1, the ARX Legacy Word Add-in plug-in includes a pull-down 
CoSign menu that can be activated from the menu bar of the Office application. 

 

The CoSign menu includes the following options: 

Menu Option Description 

Sign All-in-one signature operation. Generates a new empty digital signature field at the 
cursor location, and performs a signature operation upon this newly generated 
field. 

Add Signature 
Field 

Inserts a new empty digital signature field at the cursor location. The field displays 
the text: “CoSign Digital Signature”.  

Design Mode Toggles in and out of Design mode. 
For more information refer to Using Design Mode. 

View All 
Signatures 

Displays signatures attached to the document.  
For more information refer to Signatures List. 

Validate All 
Signatures 

Checks the validity of all existing digital signatures, and updates the images of the 
signatures according to their validity status. 
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Menu Option Description 

Clear All 
Signatures 

Removes all digital signatures but keeps the digital signature fields. 

Configure 
Signature 
Defaults 

For more information refer to Signature Default Settings – General Parameters. 

Toolbar 
Settings 

Configures which buttons are displayed in the ARX Office toolbar. 
Refer to Configuring the ARX Legacy Word Add-in Toolbar. 

Help Displays this chapter in on-line Help format. 

About Displays version information about the ARX Legacy Word Add-in, and a link to 
the ARX Web site. 

ARX Legacy Word Add-in Toolbar Options 

 ARX Legacy Word Add-in includes a Digital Signatures toolbar with the following buttons: 

Button Task 

 Toggles in and out of Design mode. 
For more information refer to Using Design Mode. 

 All-in-one signature operation. Generates a new empty digital signature field in the cursor 
location and also performs a signature operation upon this newly generated field. 

 Inserts a new empty digital signature field at the cursor location. The field displays the text: 
“CoSign Digital Signature”.  

 Displays signatures attached to the document.  
For more information refer to Signatures List. 

 Validate All signatures. 
Checks the validity of all existing digital signatures, and updates the images of the 
signatures according to their validity status. 

 Clear All signatures. 
Removes all digital signatures but keeps the digital signature fields. 

 Configure Signature Defaults. 
For more information refer to Signature Default Settings – General Parameters. 

 ARX Legacy Word Add-in Help. 
Displays this chapter in on-line Help format. 

 Displays version information about the ARX Legacy Word Add-in, and a link to the ARX 
Web site. 

Configuring the ARX Legacy Word Add-in Toolbar 

You can specify which buttons appear in the ARX Legacy Word Add-in toolbar. 
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To specify which buttons appear in the toolbar: 

1. Select Toolbar Settings from the CoSign pull-down menu. 

The Select Buttons dialog box appears.  

 

Figure 31  Select Buttons Dialog Box 

2. Check the boxes corresponding to the toolbar buttons you wish to display. 

3. Click OK. 

Adding and Validating Graphical Signatures in Word and Excel Documents 

The following sections describe the basic signing process, which includes the following 
phases: 

♦ Signing a document (refer to Signing a Document with a Graphical Signature). 

♦ Viewing signatures (refer to Viewing Graphical Digital Signatures). 

♦ Validating signatures (refer to Validating Signatures). 

In addition, if you modify the document after signing it: 

♦ Modifying a signed document (refer to Modifying Documents Containing Graphical 
Signatures). 

Signing a Document with a Graphical Signature 

To sign a Word or Excel document digitally, place digital signature fields in the desired 
locations, and sign each field. 

To place digital signature fields: 

1. Open the document you wish to sign.  

2. Position the cursor where you wish a signature to appear, and click . 

A digital signature field is created. The field displays the text “CoSign Digital Signature”. 
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Note: To change the field’s size, location, or layout, switch to Design mode by 
clicking  in the toolbar. When you finish modifying the field, click  again to 
toggle out of Design mode since you cannot sign a document in Design mode. 

3. Repeat step 2 for every signature field you wish to create. 
 

 Note: You can click  to generate a digital signature field and automatically 
perform a digital signature operation. 

 
Note: If you are signing an entire Word document using either a file-based or a 
content-based signature, keep in mind that after the first signature is generated, it is 
not possible to add new digital signature fields to the document. Therefore make sure 
to first create all the desired digital signature fields before you begin the process of 
signing them. 

To sign each signature field: 

1. Right-click the signature field and select Sign from the pop-up menu.  

2. If the Reason option was configured, the Select Reason dialog box appears. Enter or select 
a reason and click OK. 

For instructions on configuring the Reason option, refer to Signature Default Settings – 
General Parameters. For explanations on entering a reason, refer to Signature Default 
Settings – Signature Policy. 

3. If you have several certificates in CoSign, you are prompted to select the desired 
certificate.  
If you have a single certificate, it is automatically selected.  

4. If the graphical image was configured and you have several graphical images in CoSign, 
you are prompted to select the desired graphical image 
If you have a single graphical image and that graphical image should be included in the 
digital signature, you are not prompted to select the desired graphical image, and the 
graphical image is displayed at the end of the signature operation. 

 

 
Note: In Word, when using file based signatures, if you are working with a new document, 
you are prompted to save it during the digital signature operation. 

 

 
Note: When you send a document to Print, all the signatures are automatically validated 
so that the printout will display the updated state of the signatures. 

 

 
Note: When using the ARX Legacy Add-in in Office 2007, you cannot use a Legacy 
formatted digital signature in a .docx formatted document. An error message pops up if 
you try to do so. 

Clearing or Deleting Digital Signatures 

You may wish to delete signature fields or clear the digital signatures inside them. 
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To clear a digital signature from a digital signature field: 

1. Right-click the field, and select Clear from the pop-up menu. 

The digital signature is deleted from the field. The field itself remains intact. 

To delete a digital signature field: 

1. Switch to Design mode by clicking  in the toolbar. 

2. Select the field and click Delete from your keyboard. 

The digital signature field is deleted from the document. 

Viewing Graphical Digital Signatures 

Each graphical signature is displayed in the document along with one of the following 
validation symbols: 

♦ – Signature is validated. 

♦   – Signature is not validated. 

♦ – Signature needs to be validated, or is in an unknown state. 

If the signer has registered a graphical signature inside CoSign and configured it to display a 
graphical signature (refer to Signature Default Settings – General Parameters), the graphical 
signature is displayed on top of the validation symbol. 

 

Figure 32  Graphical Signature 

If the signer has not registered a graphical signature, the name of the user is displayed on top 
of the validation symbol. 

 

Figure 33  Digital Signature without Graphical Signature 

If the following elements were selected in the Signature Default Settings dialog box, they will 
also appear in the signature field (refer to Signature Default Settings – General Parameters). 

♦ The signer’s common name. 

♦ The date and time of the signature operation. 

♦ The reason for the signature. 
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Figure 34  Signature with Additional Details 

Validating Signatures 
 

To validate a graphical signature attached to a document: 

1. Open the document. 

2. Right-click the signature and select Validate from the pop-up menu. 

Starting from version 4.1, you can configure the ARX Office plug-in to perform an automatic 
validation of all digital signatures that exist inside the document. Refer to Setting Microsoft 
Office Configuration. 

For information on how to view the signatures’ status, refer to Signatures List. 

Modifying Documents Containing Graphical Signatures 

Modifying the signed data in a Word or Excel document invalidates all its relevant signatures 
(depending on the signature scope) and an   is displayed in each signature field. Refer to 
Word Specific Signing Features and Excel Specific Signing Features for more details about the 
different signing options in Word and Excel, which define the scope of the digital signature. 

If you attempt to save a file based signed Word document that is modified, the following 
message appears, “Saving will remove all digital signatures in the document. Do you want 
to continue?” To delete the file based signatures and save the document, click Yes. 

Word Specific Signing Features 

Starting from version 3.4, the CoSign Client enables generating two new content-based types 
of signatures in Word documents, in addition to the file-based signature:  

♦ Document content signature – This is the new default signature. This signature signs the 
entire textual and visible content of the document, but not the entire file. 
This mode is recommended in document management systems to avoid file access or 
network access to the document file. 

♦ Section based signature – Signs only the content of a specific section in the document. 
This functionality is useful for Word documents that are based on workflow operations. 
Using section based signatures, each signer edits and signs a specific section, in no way 
affecting the signatures on other sections. 

For backward compatibility, the file-based signature can also be used. 



3 CoSign User Guide 

44 

 
 

 
Note: Currently, SAPI (CoSign’s signature API) supports only file-based signature 
operations upon a given Word file. 

Excel Specific Signing Features 

In Excel, only content-based signatures are supported. File-based signatures are not supported. 
You can select both the scope (workbook, active sheet, or selected area), and the content 
within the scope that will be signed. 

The different scopes include: 

♦ Active sheet – All the relevant content in the active sheet will be signed. Any change in 
the relevant content within the active sheet will invalidate the signature, while any change 
in other sheets will have no effect on the signature.  
This is the default value. 

♦ Workbook – All the relevant content in all the workbook's sheets will be signed. Any 
change in the relevant content within any sheet of the workbook will invalidate the 
signature. 

♦ Selection – Only the relevant content in the cells of the selected area will be signed. Any 
change in the relevant content of any of the selected cells will invalidate the signature, 
while any change in other cells will have no effect on the signature. You must select the 
cells before signing the signature field, and you can only sign a single continuous 
selection, not multiple selections. 

 
Note: To view which selected area a specific signature applies to, right-click the 
signature field and select Show from the pop-up menu. The signed cells are 
highlighted. 

The different values for the signature content include:  

♦ Cell Values – The values of the cells will be signed. 

♦ Cell Formula – The cell formula will be signed.  

 
Note: If the cell formula depends on other unsigned cells, then even if the values 
of those cells change and cause the selected cells value to change, as long as the 
formula remains the same, this change does not invalidate the signature. 

♦ Cell Properties – The following cell properties will be signed: font name, font style 
(indication whether the text is bold or italic), font size, hide row, and hide column. 

Configuring Signature Defaults 

The Signature Default Settings dialog box enables setting defaults for the appearance and other 
parameters of the graphical signatures.  
 

 
Note: You can configure defaults using the CoSign Configuration Utility. Refer to Setting 
Microsoft Office Configuration. 
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You can set general defaults for all signatures in a document, or configure a specific signature 
field. 

To configure signature defaults for all signatures in a document: 

♦ From the Digital Signatures toolbar, click . 
 

 
Note: The new signature defaults only affect future signature fields, not existing 
ones. 

To configure a specific signature field: 
 

 
Note: You can configure a specific signature field only if the field is empty. 

♦ Right-click a signature and select Settings from the pop-up menu. 

The Signature Default Settings dialog box includes the following tabs: 

♦ Settings – Enables setting general signature parameters. Refer to Signature Default 
Settings – General Parameters. 

♦ Time Format – Enables setting date and time parameters. Refer to Signature Default 
Settings – Date and Time Format. 

♦ Scope of Signature – Enables setting the different signing options for Word documents 
or Excel documents. Refer to Signature Default Settings – Scope of Signature (Word) and 
Signature Default Settings – Scope of Signature (Excel). 

♦ Signature Policy– Enables defining Signature operation policy. At this stage, you can 
only define who can clear an existing signature. Refer to Signature Default Settings – 
Signature Policy. 

 

 
Note: The Microsoft Office Compatible Signature field in the Settings tab is enabled 
only in Word. 
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Signature Default Settings – General Parameters 

 

Figure 35  Signature Default Settings – Settings Tab 

In the Settings tab you can set the following signature default settings: 

♦ Signature  

♦ Dependent – Specify whether the digital signature is dependent or independent. For 
more information on setting up dependent signatures, refer to Imposing Dependency. 

♦ Microsoft Office compatible signature – Relevant only to Word documents. If this 
option is set, the ARX Word add-in generates an XP compatible digital signature that 
can be validated in Word XP or Word 2003 without installing a plug-in. 
This option has differing functionality depending on the type of digital signature. If 
the digital signature is content-based then the ARX Word add-in generates an 
additional XP compatible signature. 
If it is a file-based digital signature, the generated digital signature is an XP 
compatible signature. Refer to Validating Graphical Signatures in Word documents 
Without Using the ARX Legacy Word Add-in Plug-in. 
 
When using Office 2007, keep in mind that there is a difference between signatures 
that are applied to .doc documents and signatures that are applied to .docx documents. 
This section is relevant only for .doc documents. In this case, the whole document is 
locked and therefore after performing such a signature, you cannot perform any 
modification to the document, including clearing the digital signatures. 

♦ Show – Specify which elements will appear as part of the graphical image of the digital 
signature: 
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♦ Graphical image – Whether to display a graphical signature image. 

♦ Date and time – Whether to display the date and time of the signature. 

♦ Reason – Whether to display the reason for the signature. 

♦ Signed by – Whether to display the signer’s name as listed in the signer’s certificate. 

♦ Captions – Specify whether to display the title of the element, for the elements selected in 
the Show section. 

♦ Restore Defaults – Specify whether to restore all the default values. 
This field is available only when clicking  to configure defaults for all signatures in the 
document. 

Signature Default Settings – Date and Time Format 

 

Figure 36  Signature Default Settings – Time Format Tab 

In the Time Format tab you can set the following signature default settings: 

♦ Format – Use the drop down lists to specify the desired Date Format and Time Format. 
The date and time format notation are explained in the dialog box. 

♦ Display GMT Offset – Specify whether to display the time zone of the signature operation 
in relation to GMT. 

 
Note: The signature time is taken from CoSign, while the time zone is taken from 
the local machine. 
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Signature Default Settings – Scope of Signature (Word) 

 

Figure 37  Signature Default Settings – Scope of Signature Tab (Word) 

In the Scope of Signature tab that appears in Word you can set the following signature 
default settings: 

♦ Scope – Specify the content to be signed:  

♦ Entire File – The Word file itself is signed. This mode was the only option prior to 
CoSign version 3.4. 

♦ Document Content – All the text and visible content of the document is signed. 

♦ Containing Section – The content of the current section is signed. 

♦ Section Number - The content of this section is signed. 

♦ In addition to text, signature applies to – Enables specifying that additional information 
be signed in the case of a content-based signature. 

♦ Location & Size of Tables and Objects – The location and size of tables and objects 
within the scope of signature are also included in the digital signature. This may cause 
a signature validation failure if content changes. 

♦ Field codes – The signing process includes the result of dynamically changing fields 
(smart tags) inside the headers and footers. This may cause a signature validation 
failure if content changes. 

♦ Form Fields & Content Controls – The signing process includes form fields and 
content controls. This may cause a signature validation failure if content changes. 
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Signature Default Settings – Scope of Signature (Excel) 

 

Figure 38  Signature Default Settings – Scope of Signature Tab (Excel) 

In the Scope of Signature tab that appears in Excel you can set the following signature 
default settings: 

♦ Scope – Specify the cells to be signed:  

♦ Active sheet – All the relevant content in the active sheet will be signed. 

♦ Workbook – All the cells in the workbook will be signed. 

♦ Selection – Only the cells of a specific selected area will be signed. There are two 
ways for specifying the selected area to be signed: 

♦ Specify the top left and the bottom right cells of the desired area, separated by a 
colon, in the selection field. See Figure 38 for an example.  
In this case the signer merely right clicks and signs the signature field. 

♦ If no selection is specified in the selection field, the signer selects the cells to be 
signed and then right clicks and signs the signature field. 

♦ Signature content – Specify the cells-related content to be signed:  

♦ Cell value – The cell values will be signed. 

♦ Cell formula – The cell formula will be signed. 

♦ Cell properties – The following cell properties will be signed: font name, font style 
(indication whether the text is bold or italic), font size, hide row, and hide column. 
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Note: You must set either Cell Values or Cell Formula or both. 

Signature Default Settings – Signature Policy 

 

Figure 39  Signature Default Settings – Signature Policy Tab 

In the Signature Policy tab you can set the following signature default settings: 

♦ Clear Policy – Specify the policy for clearing an existing signature field: 

♦ Anyone – Anyone can clear the signature field. 

♦ No One – No one can clear the signature field. 

♦ Signer only – Only the signer can clear the signature field. 

Selecting a Reason 

The Select Reason option enables you to obligate a signer to enter the reason for the 
signature. 

The Select Reason dialog box appears during the digital signature process if the Reason 
option is selected in the Signature Default Settings dialog box (refer to Signature Default 
Settings – General Parameters). 
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Figure 40  Select Reason Dialog Box 

To specify the reason for signing:  

1. Enter the text of the reason for signing in the Select the reason for signing field. 

OR 

Select a reason from the list of predefined reasons. On selection, the text appears in the 
Select the reason for signing field. 

2. Click OK. 

You can also edit the list of predefined reasons using the following buttons: 

♦ Set as Default – The currently selected item in the list of predefined reasons becomes the 
default reason. This reason is displayed on all subsequent appearances of the Select Reason 
dialog box. 

♦ Add – The current text in the Select the reason for signing field is appended to the list 
of predefined reasons. 

♦ Delete – The currently selected item in the list of predefined reasons is removed from the 
list. 

♦ Restore Defaults – Restore the list of reasons as listed in the CoSign Configuration utility 
in the Microsoft Office – Reasons section 

 

 
Note: Clicking Cancel cancels the digital signature operation. 
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Imposing Dependency 

You can use the Dependent Signatures option to impose a chronological hierarchy of 
signatures. For example, when you wish to ensure that a document will be signed first by the 
document’s author, then by the author’s superior, and then by the regional manager. 

To impose dependency in the digital signature process:  

1. From the Digital Signatures toolbar, click . 

The Signature Default Settings dialog box appears.  
2. In the Settings tab, select Dependent signature type (refer to Signature Default Settings – 

General Parameters). 

All signature fields you place in this document are fields for dependent signatures, and the 
order of the signing dictates the hierarchy of the signatures. For example, in a document 
with four signatures, an attempt to re-sign the first signature will invalidate the second, 
third, and fourth signatures; an attempt to re-sign the second signature will invalidate the 
third and fourth signatures; while an attempt to re-sign the last signature will not invalidate 
any signature. 

3. Position the cursor where you wish the first signer to sign, and click  to insert a 
signature field. 

4. Continue inserting as many signature fields as desired, taking care to place the second field 
where you wish the second signer to sign, the third field where you wish the third signer to 
sign, etc. 

A document with dependent signatures should typically contain text within the document that 
details the correct order of signing, and directs the signers to their respective signature fields.  

Dependency in Excel 

Dependency in Excel is based on the type of signature, as follows: 

♦ Signatures based on an active sheet are dependent only on signatures inside the active 
sheet and not in other sheets. 

♦ Signatures based on a workspace can be dependent on signatures in other sheets in the 
same workspace. 

♦ Dependency cannot be enforced on signatures that are based on a selected area. 

Using Design Mode 

Design mode enables you to change the size, location, and layout of the signature field, as well 
as delete a signature field. 

To use Design mode: 

1. Click  in the toolbar to switch to Design mode. 



Signing Microsoft Office Documents 3 
 

 53 

2. Perform any of the following, as desired: 

♦ Modify the field’s location – Select the signature field and move or resize the field. 

♦ Modify the field’s object's format: 

♦ In Word, you can change the field’s size and layout. Right-click the signature field 
and select Format Control from the pop-up menu. The Format Control dialog box 
appears. 

 

Figure 41  Word’s Signature Field Format Control Dialog Box 

Use the Layout tab to specify the layout settings of the signature field. 

Use the Size tab to specify the size settings of the signature field. 

♦ In Excel, you can change the field’s colors and lines, size, and properties. Right-
click the signature field and select Format Object from the pop-up menu. The 
Format Object dialog box appears.  
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Figure 42 Excel's Signature Field Format Object Dialog Box 

Use the Colors and Lines tab to specify the color and line settings of the signature 
field. 

Use the Size tab to specify the size settings of the signature field. 

Use the Properties tab to specify the positioning and printing options of the 
signature field. 

♦ Delete the signature field – Select the field and press Delete on your keyboard. 

3. When you finish modifying the signature field, click  again to toggle out of Design 
mode. 
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Signatures List 

In the Digital Signatures dialog box you can view the list of all actual signatures in a 
document. If the signatures are dependent, you can view the dependent signatures of a given 
signature. 

 

Figure 43  Digital Signatures Dialog Box 

To view the list of all signatures: 

1. From the Digital Signatures toolbar, click . 

The Digital Signatures dialog box appears, showing all actual signatures (not signature fields) 
in the document. 

To view dependent signatures:  

♦ Right-click a dependent signature and select Dependencies from the pop-up menu. 

The Digital Signatures dialog box appears, showing all the signatures on which the specified 
signature depends. 
 

Note: In Excel, signatures that apply to a selected area never depend on other signatures. 
Therefore choosing the Dependencies option for such signature fields will show no 
signatures in the Digital Signatures dialog box. 
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The icon to the left of the signer’s name indicates the signature’s status, as follows: 

Icon Task 

 Both the signature and certificate are valid. 

 
A minor problem is detected (for example, the ROOT certificate is not installed 
on this machine and therefore the certificate cannot be validated). 

 A major problem is detected (for example, the document was tampered with 
after signing). 

To view additional information about the signatures and certificates, refer to Signature Details. 

Signature Details 

To view additional information about the signatures and certificates: 

1. Open the Signature Details dialog box in one of the following ways: 

♦ Select a signature in the Digital Signatures dialog box and click Details. The 
Signature Details dialog box appears. 

♦ Right-click a signature field within the document and select Details from the pop-up 
menu. The Signature Details dialog box appears. 

 

Figure 44  Signature Details Dialog Box  
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2. To view certificate information, click View Certificate. The Certificate dialog box 
appears. 

 

Figure 45  Certificate Dialog Box  

The Certificate dialog box includes the following tabs: 

♦ General – Provides general certificate information, including the intended use of the 
certificate, to whom the certificate was issued, the certificate issuer, and the 
certificate’s expiration date.  

♦ Details – Provides additional details about the certificate.  

♦ Certification Path – Provides information about the certificates at a higher 
hierarchical level in the chain that approve the current certificate. 

Validating Office Graphical Signatures 

The following sections describe how a user who is not using CoSign can validate graphical 
signatures that were attached using CoSign. 
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Validating Graphical Signatures Using the ARX Legacy Word Add-in Plug-in 

If you are not using CoSign, you may still validate graphical signatures that were attached 
using CoSign. This is useful if you receive documents from a company or organization that 
uses CoSign internally.  

To validate signatures: 

1. Obtain the following from a reliable representative of the organization using CoSign: 

♦ A copy of ARX’s Office Verifier that includes the ARX digital signature plug-in for 
Word and Excel. This copy can be installed using the web-based ARX verifier 
software. 

♦ The organization’s ROOT CA Certificate (.cer file).  

 
Note: For instructions on how to install the ROOT certificate to a .cer file, refer 
to Installing the ROOT Certificate. 

2. Install the ARX Office Verifier from the ARX web site or from the organization that 
has an installed CoSign appliance (refer to Installing the CoSign Verifier. 

3. Install the organization’s ROOT CA Certificate (refer to Installing the ROOT Certificate). 
Alternatively, install the organization’s ROOT CA Certificate using the web-based ARX 
verifier software. 

 
Note: If an external CA is used, or the CoSign certificate is based on a WorldWide 
verifiable CA, there is no need to install the ROOT certificate. 

4. Validate the signature (refer to Validating Signatures).  

Validating Graphical Signatures in Word documents Without Using the ARX Legacy Word 
Add-in Plug-in 

If you do not wish to install CoSign nor the ARX Legacy Word Add-in, you can still view the 
graphical signature that was attached using CoSign and validate it, without installing ARX 
Legacy Word Add-in. This is useful if you receive documents from a company or organization 
that uses CoSign internally.  
This operation is only applicable for Word XP, Word 2003, and Word 2007, in cases where 
there is a single graphical signature inside the document. 
 

 
Note: Although the graphical signature can be viewed, the right-click pop-up menu is not 
available. It is available only when the ARX Legacy Word Add-in plug-in is installed. 
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To validate a digital signature without using CoSign, refer to Viewing and Validating 
Signatures without Graphical Images in Word and Excel XP/2003. 

Signing Word and Excel XP/2003 Documents without Graphical 
Signatures  

Word and Excel XP/2003 support digital signatures, enabling seamless integration with 
CoSign. Only the ARX CoSign client needs to be installed and no additional plug-ins are 
required to digitally sign or validate a signature in a document. For information on installing 
this component, refer to Installing the CoSign Client. 

Signing a Word or Excel XP/2003 Document without a Graphical Signature 

To sign a document in Word or Excel XP/2003 without a graphical signature: 

1. Open the document you wish to sign in its associated application. 

2. Open the Tools menu and select Options. The Options dialog box appears. 
3. Select the Security tab and click Digital Signatures. The Digital Signature dialog box 

appears. 

 

Figure 46  Digital Signature Dialog Box 

4. Click Add. The Select Certificate dialog box appears, listing all your certificates. 
5. Select the desired certificate and click OK. Your signature is appended to the list in the 

Digital Signature dialog box. 
6. Click OK. The document is saved and your signature is attached to the document. 
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Note: You can attach several digital signatures of different users to each Word or Excel 
XP/2003 document. 

Viewing and Validating Signatures without Graphical Images in Word and Excel 
XP/2003 

To view attached signatures that do not contain graphical images: 

In Word XP/2003: 

1. Open the document in Word XP/2003. 

2. In the status bar at the bottom of the window, double-click . The Digital Signature 
dialog box appears and all the valid certificates are displayed. If this icon is not visible, no 
signatures are attached to the document. 

In Excel and Word XP/2003: 

1. Open the document in Word or Excel XP/2003. 

2. Open the Tools menu and select Options. The Options dialog box appears. 

3. Select the Security tab and click Digital Signatures. The Digital Signature dialog box 
appears and all the valid certificates are displayed. 

 

Figure 47  Digital Signature Dialog Box 

Office XP/2003 also checks whether the certificate exists in a Certificate Revocation List 
(CRL). If the certificate exists in a CRL, you receive a validation error. 
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Note: If the document has been tampered with, you cannot view its certificate. In Excel 
there is no indication at all that the file was ever signed. 

 

 
Note: In Excel XP/2003, the window title of a signed document indicates that the 
document was signed, but the status bar at the bottom of the window does not display the 
validation status of the signature. 

To validate signatures: 

1. Obtain the ROOT CA Certificate (.cer file) from a reliable representative of the 
organization using CoSign. 

2. Install the organization’s ROOT CA Certificate (refer to Installing the ROOT Certificate). 

 
Note: If an external CA is used, or if the CoSign certificate is based on a 
WorldWide verifiable CA, there is no need to install the ROOT certificate. 

3. Click View Certificate… to view the certificate information and verify that its CRL and 
certificate chain are correct.  

Signing PowerPoint XP/2003 Documents 

CoSign enables you to add and validate signatures in both PowerPoint XP and PowerPoint 
2003. 

In PowerPoint XP/2003 documents, perform digital signature operations in the same manner as 
in Word/Excel XP/2003 documents (refer to Signing Word and Excel XP/2003 Documents 
without Graphical Signatures). 
 

 
Note: In PowerPoint XP/2003, the window title of a signed document indicates that the 
document was signed, but the status bar at the bottom of the window does not display the 
validation status of the signature. To validate a digital signature, click View Certificate in 
the Digital Signatures dialog box. 





 

 63 

Chapter 4: Signing InfoPath Forms 

♦ CoSign enables generating and validating graphical digital signatures for Microsoft 
InfoPath forms, and integrating the graphical digital signatures into the general application 
flow. 

♦ InfoPath itself supports multiple and sectional digital signatures. ARX’s solution for 
InfoPath combines these features of InfoPath with the graphical image capabilities of 
CoSign, to create a complete solution that enables you to design a form with as many 
signatures as desired. Each signature can cover any portion of the form, and most 
importantly, the signature is visible and is treated like any other field in the form. 

♦ The integration of the graphical signature is performed in the form’s template, as explained 
in detail in this chapter. 

 

Note:  All the screen captures in this chapter were made using the ABSNCREQ template 
sample (ABSNCREQ.xsn) that is included in the InfoPath installation. 
 

Note:  In this chapter it is assumed the reader has a working knowledge of InfoPath forms. 

Prerequisites for Signing an InfoPath Form 

CoSign enables you to add graphical signatures to InfoPath forms in Office 2003/2007. To 
enable graphical and digital signatures, you must install the ARX CoSign Client and MS 
Office client components. For information on installing these components, refer to Installing 
the CoSign Client. 
 

Note:  Since ARX’s solution for InfoPath does not require any plug-in installation, you can 
install Office 2003 after the CoSign components are already installed. 

Digital signatures are supported in InfoPath starting from Service Pack 1 for Office 2003 and 
in Office 2007. Therefore, verify that service pack 1 or later is installed prior to performing 
any digital signature related operations on InfoPath forms, and prior to running the ARX 
InfoPath Designer. In addition, when opening a template that was created before Service Pack 
1 was installed, click Yes when InfoPath asks you whether to add the Service Pack features 
(Figure 48). 
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Figure 48  Adding Service Pack Features 

Graphically Signing an InfoPath Form 

The graphical signing operation on an InfoPath form is composed of three phases: 

1. Adding a Graphical Signature Object in Design mode – in this phase, the designer adds 
one or more graphical signature data objects to the Data Source structure, places the 
object(s) (signature graphical image, signature time, or both) in the actual form, and 
defines the signable data and the signed areas. 

2. Adding the CoSign Digital Signatures Toolbar to the template by running ARX InfoPath 
Designer from the Start menu. 

3. Signing an InfoPath Form with a Graphical Signature – signing any of the signatures in 
the form by the end user, and embedding both the graphical and the digital signatures in 
the form. 

 

Note:  If a view is added to a template after running ARX InfoPath Designer, you must run 
ARX InfoPath Designer again. 

Based on InfoPath’s built-in support of digital signatures, ARX’s solution also supports 
multiple, sectional, and dependent signatures without adding any special and proprietary menu 
options or GUI but by using InfoPath’s standard user interface. 

The following sections provide a detailed step-by-step explanation of the signing process. 

Adding a Graphical Signature Object 

Adding a graphical signature object to an InfoPath form template is performed during form’s 
layout and data design phase. It includes the following tasks: 

1. Configuring the Template with the Domain Security Level. 

2. Adding the Graphical Signature Object to the Data Source. 

3. Placing the Graphical Signature Object on the Form Layout. 

4. Defining Sets of Signable Data. 
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5. Creating Multiple Signatures in a Form (optional). 

Configuring the Template with the Domain Security Level 

Configure the template you are designing with the Domain security level. 

To set the security level of the form:  

1. Select Tools > Form Options. The Form Options dialog box appears. 

2. Select the Security tab (Figure 49). 

 

Figure 49  Security Tab 

3. Select Domain in the Security Level section. 

4. Click OK. 
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Adding the Graphical Signature Object to the Data Source 

The ARGraphicalSignature object is defined in the Data Source as a group that consists of one 
signature image field and two field attributes – signature time (the time of the signing 
operation) and signed area (the index of the area to which this signature image belongs).  

To create the graphical signature data object: 

1. Open a form in Design mode. If Data Source is not visible in the task pane, select Data 
Source… from the View menu. See Figure 50. 

2. Add a new group where desired in the Data Source structure and name it as desired.  
Make sure the Repeating box is unchecked. 

3. Under the new group, add a field named ARGraphicalSignature of type Field (element) 
and of Data type Picture or File Attachment (base64).  
Make sure the Repeating and Cannot be blank boxes are unchecked. 

4. Under ARGraphicalSignature, add the following field attributes of data type Text(string): 

♦ SignatureTime 

♦ SignedArea (for CoSign internal use) 

The default value in both attributes should be left empty. Do not check the Cannot be 
blank box. 

 

Note:  The field and attribute names are case sensitive. 

 

Figure 50  Data Source 
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Note:  Do not change the ARX Graphical Signature object structure. Adding groups or fields 
to this structure may cause unexpected behavior.  

Placing the Graphical Signature Object on the Form Layout 

After creating the ARX Graphical Signature object in the Data Source you must place it on the 
form layout, so that when the digital signature is created the graphical image will be displayed 
on the form. You can decide whether you want only the graphical image, or both the image 
and the signature time. 

To place the graphical signature object on the form layout: 

1. Place the signature image and signature time fields, using either of the following 
alternative methods (illustrated in Figure 51): 

♦ Method A:  Drag the whole group from the Data Source window to the layout where 
you want it to be displayed.  
Select Section with control from the pop-up menu that displays when you release the 
mouse button. A new section containing three fields is created on the layout. 
Remove the Signed area field and its label since they are intended for internal CoSign 
use.  
Drag additional fields as desired.  
See for example the left side of Figure 51. 

♦ Method B:  Drag the ARGraphicalSignature field from the Data Source window to the 
layout where you want it to be displayed.  
Select Picture from the pop-up menu that displays when you release the mouse button.  
Then drag the SignatureTime field in the same manner. 
See for example the right side of Figure 51. 
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Method A 

 

Method B 

 

Figure 51  Methods of Placing the Graphical Signature Object on the Form Layout 

2. Set the signature image size. 
Set the graphical image size according to the size of the actual graphical image. You can 
do either of the following: 

♦ Right click the object and select Picture Properties. Click the Size tab and specify 
the optimal settings. 

♦ Leave the default Auto size. In this case, the size of the picture object is dynamically 
changed by the signing operation. 

 

Note:  Make sure the time field is long enough to contain the selected time format. For more 
information about selecting the time format, refer to Signature Default Settings – Date and 
Time Format. 

Defining Sets of Signable Data 

When the graphical image is both defined in the Data Source and is located as desired on the 
form layout, the signable data (signed area) should be defined. This operation links a group of 
fields in the form to the standard InfoPath digital signature and its graphical representation. 

The signed area can be either the entire form, or a selected area of the form. 

To define the signature on the entire form:  

1. Select Tools > Form Options. The Form Options dialog box appears. 

2. Select the Digital Signatures tab. 
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3. Select enable digital signature for the entire form, and click OK. Selecting this option 
automatically adds to the Data Source a new group named signatures of data type 
DigitalSignaturesType if this group doesn’t already exist. 

To define the signature on a selected area of the form:  

1. Select Tools > Form Options. The Form Options dialog box appears. 

2. Select the Digital Signatures tab. 

3. Select enable digital signature for specific data in the form. 

4. Click Add to add a new set of signable data. The Set of Signable Data dialog box appears 
(Figure 52). 

 

Figure 52  Set of Signable Data Dialog Box 

5. Enter a name for the new set (or area). This name will show up again when you choose to 
sign the form and there is more than one area to sign on. 

6. Specify which fields or groups you want the signature to cover. These objects will be 
locked after signing and any change in any of them will invalidate the signature.  

♦ To specify a single field/group, click the Select XPath button  and select a single 
object from the selection dialog box. 

♦ To specify multiple fields/groups, select each field/group and copy the resultant string 
from the Fields and groups to be signed text box into a text editor. When you have 
all the strings, copy them back to the text box with a ‘|’ separating the individual 
strings (see Figure 53). 
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Note:  You must also include the graphical signature group itself in the 
fields and groups to be signed, either directly by including it in the 
fields and groups list, or indirectly by having it included under one of the 
groups in the list. 

 

Figure 53  Strings Separated by ‘|’ 

7. Select a signature option (see Figure 52), as follows:  

• Allow only one signature – Only one signer can sign this area. 

• All the signatures are independent (co-signing) – Multiple signers for this area are 
allowed, and the current signature does not sign on previously made signatures of this 
area. This means you can remove previous digital signatures anytime, without 
invalidating the current signature.  

• Each signature signs the preceding signature (counter-signing) – Multiple signers 
for this area are allowed, and the current signature signs on previously made signatures 
of this area. This means that removing any of the previous digital signatures will 
invalidate the current one. 

 
Note:  If you select either of the last two options, both the digital and the 
graphical signatures are added to the form when the first signer signs this 
area. All subsequent signers of the same area cause addition of only their 
digital signature, while the ARX graphical image and ARX signature time 
remain unchanged. 

8. Edit the Signature confirmation message if desired. This message is displayed to the signer 
when InfoPath shows the signer the form to be signed and asks for final approval. Refer to 
Signing an InfoPath Form with a Graphical Signature for more information. 

9. Click OK. 

10. Repeat steps 4 through 9 for every new set of signable data you wish to add. 

Creating Multiple Signatures in a Form 

There are two different scenarios where more than one signature needs to be placed in a single 
form.  

♦ Creating Multiple Independent Signatures – Several signers need to sign a section or the 
entire form, but the signatures do not depend on one another. For example, a list of 
employees’ signatures stating that each of them read a certain document.  

♦ Creating Multiple Dependent Signatures – The signatures depend on one another, that is, 
if a signature is changed, then all subsequent signatures are invalidated. For example, a 
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manager who approves and signs a purchase order that was filled and signed by an 
employee. 

Creating Multiple Independent Signatures 

To create multiple independent signatures:  

1. Create the first signature object in the Data Source as described in Adding the Graphical 
Signature Object to the Data Source. 

2. Add a new group in the Data Source structure and name it as desired, making sure the 
Repeating box is not checked. 

3. Right click the ARGraphicalSignature field and select Reference.  
The Reference Field or Group dialog pops up (Figure 54). 

 

Figure 54  Reference Field or Group 

4. Select the newly created Signature group and click OK. 
The ARGraphicalSignature field, including its SignatureTime and SignedArea attributes, 
are automatically added to the new Signature group. 

5. Place both signatures on the form layout, as described in Placing the Graphical Signature 
Object on the Form Layout. 

6. Define the set of signable data for each signature as described in Defining Sets of Signable 
Data. 
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Following is an example of how the form will look: 

 

Figure 55  Form with Multiple Signatures 

Creating Multiple Dependent Signatures 

To create two or more dependent signatures, follow the procedure outlined above in Creating 
Multiple Independent Signatures, but perform the following when Defining Sets of Signable 
Data: 

1. The set of signable data for the second signature should include the first graphical 
signature data object, whether directly or indirectly, so that a change in the image of the 
first signature will invalidate the second signature. 

2. You must arrange the graphical signature objects in the Data Source so that the signature 
that should be signed first (the employee’s in our example), is located in a higher place in 
the Data Source structure. This does not necessarily imply a higher nesting level, but if 
you flatten the whole Data Source structure, the first signature data object should appear in 
a higher position. 
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Note:  If user A, who is supposed to be the second signer, signs before user B, user A will lock 
user B’s graphical signature field. This prevents user B from being able to add his graphical 
signature. However, InfoPath’s digital signature for user B will be added successfully. A 
message pops up informing you that only the digital signature can apply. 

Adding the CoSign Digital Signatures Toolbar 

The CoSign Digital Signatures toolbar for InfoPath must be added to any form template that 
requires graphical signatures. To add this toolbar, the ARX InfoPath Designer application 
should be run once in a template’s lifetime. 
 

Note:  The addition of the CoSign Digital Signatures toolbar is not dependent on the graphical 
image group creation in the data source; it can be done either prior to or after the graphical 
signature is created in the data source. 

To add the CoSign Digital Signatures toolbar: 

1. Run Start > Programs > ARX CoSign > CoSign Control Panel. The Control Panel 
appears.  

2. Double click Design InfoPath template. The ARX InfoPath window appears 
(Figure 56). 

 

Figure 56  ARX InfoPath Window 

3. Find out your form’s script language as follows: 

a. Open your form in Design mode. 
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b. Select Tools > Form Options (Figure 57). 
Select the Advanced tab. 
The script language being used appears in the Form code language field. 

 

Figure 57  Finding Out the Script Language 

c. Click OK to exit the form. 

4. Specify the script language of the form in the Script menu.  

 

5. Open the template file (File > Open).  
Since adding the CoSign Digital Signatures toolbar changes the template file, it must not 
be open by InfoPath at the same time. 

6. Select File > Generate.  
Some log entries should appear in the main application window.  

♦ If the last log string is SUCCESS, the operation of adding the CoSign Digital 
Signatures toolbar was completed successfully.  
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♦ If the last log string is not SUCCESS, an error has occurred. Make sure the file is 
neither read-only nor opened by InfoPath, and select File > Generate again. 
If that was not the source of the problem, contact ARX technical support for 
assistance. 

7. Select File > Close to close the ARX InfoPath Designer application. 

The CoSign Digital Signatures toolbar is added, and the InfoPath template is now ready for 
distribution. 
 

Note:  ARX InfoPath Designer saves a backup copy of the original template file before it 
changes the file. This backup copy is used for automatic restore in case the application fails to 
add the toolbar. This ensures that if the operation fails, the original template file remains the 
same. 
Running ARX InfoPath Designer again with the same template, overwrites the last backup with 
the current template file. 

Signing an InfoPath Form with a Graphical Signature 

After the first two phases are complete, the end user can fill and sign a form based on the 
template. 

To sign an InfoPath form: 

1. Open a form and fill all the required fields. 

2. Select Sign in the CoSign Digital Signatures toolbar (Figure 58).  
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Figure 58  CoSign Digital Signatures Toolbar 

3. Select the area name to be signed: 

♦ If only one area is defined, that area is automatically selected. 

♦ If more that one area is defined in this template, the area selection dialog box pops up 
(Figure 59). Select one area and click OK. 
The Digital Signature Wizard – Please select the part of the form window appears. 

 

Figure 59  Area Selection Dialog Box 

4. If there is more than one graphical image, a graphical image selection window appears, 
and the user must specify the desired graphical image. 
If there is only one graphical image for the user, that graphical image is selected. 
If the user has no graphical image, an error message appears. 
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5. A certificate selection window appears (Figure 60). Select the certificate you want to sign 
with and click Next. 

 

Figure 60  Selecting a Certificate 

6. Optionally type a comment that will be attached to the signature (Figure 61) and click 
Finish. 

 

Figure 61  Adding a Comment to a Signature 

7. Verify that the document looks as expected (Figure 62), then check I have verified this 
content before signing and click Sign.  
 
Note that the signature confirmation message is the one that was entered when the signed 
area was defined (refer to Defining Sets of Signable Data). 
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Figure 62  Signature Confirmation Message 

The form is now digitally signed.  

If you chose to display the signature time, it is shown as well (Figure 62).  
 

Note:  The time displayed on the form might differ slightly from the one stored with the 
signature because the time displayed on the form is taken from CoSign, while the time stored 
with the signature is taken by InfoPath from the machine's clock. 
 

Note:  After selecting the area to be signed, the graphical image and the time are written to 
the form even if the signing operation failed or was cancelled. In this case, you must manually 
remove the graphical image and the time field from the form (refer to Clearing a Graphical 
Signature). 
 

Note:  Although the graphical image field is of type Picture, do not insert any picture into it 
yourself. Doing so might lead to unexpected results in the signing operation. 

Clearing a Graphical Signature 

ARX’s solution for InfoPath contains two components: the ARX graphical image object and 
InfoPath’s standard digital signature. Since the ARX graphical image object is one of the data 
objects being signed, it is locked until you remove the associated InfoPath digital signature. 
Therefore, clearing a graphical signature entails first deleting the InfoPath digital signature, if 
it exists, and then deleting the ARX graphical image object. 

To clear a graphical signature from an InfoPath form: 
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1. Remove the digital signature for the same signed area, if exists, as follows:  
Click , select the signature to remove, and click Remove (Figure 63). 

 

Figure 63  Digital Signatures Dialog Box 

2. Remove the ARX graphical signature as follows:  
In the CoSign digital Signatures toolbar select Clear Signature Image (Figure 58). If 
more than one set of signable data is defined, you are prompted to select the signed area 
you wish to clear, otherwise it is automatically selected. 

Note that there are cases where only the ARX graphical object is added to the InfoPath form 
while the InfoPath digital signature is not. In these cases, perform only step 2. The following 
scenarios can lead to such cases: 

♦ There is no certificate to select from. 

♦ The operation was cancelled by the user. 

♦ The signing operation failed. 

Validating a Signature 

Validation of digital signatures in InfoPath is the same whether you use a graphical signature 
or not. The validation operation is performed by the InfoPath standard support in digital 
signatures, and it is never attached to a specific signature image. 

When validating a form, the graphical image of the signature as well as the date and time fields 
are treated like any other data in the form. 

To validate a signature in a form: 

1. Click . The Digital Signatures dialog box pops up (Figure 63) with a list of all the 
signatures in the form. 

2. Check the value in the Status column for a specific signature. 
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♦ If the status is Valid, the signed data was not changed since it was signed. 

♦ If the status is Invalid, then the signed data was tampered with. 

 
InfoPath verifies the digital signatures in a form when the form is opened. 
If a digital signature is not valid, a pop up message appears with the 
notification: 
One or more digital signatures in this form could not be verified. 

3. Click View Signed Form to view the form as it was at the time the signature was created. 

4. Click View Certificate to learn more about the signing certificate. Refer to Signature 
Details for more information about viewing a certificate.  

 

Note:  InfoPath supports sectional signing, therefore a signature can still be valid even though 
the form was changed, as long as the fields that are part of the signed area were not changed.  
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Digital Signatures Support without Graphical Signatures 

InfoPath forms can be digitally signed by CoSign certificates without using the graphical 
image feature. To do so, use only InfoPath’s built-in functionality to perform all tasks, as 
follows: 

♦ Defining sets of signable data – The first step in integrating digital signatures in an 
InfoPath template is to define one or more sets of signable data when designing the form 
template. The definition of signable data is the same whether you use a graphical image or 
not. Refer to Defining Sets of Signable Data for instructions on how to define a set of 
signable data in a template. 

♦ Signing an InfoPath Form without a Graphical Signature – Refer to Signing an 
InfoPath Form without a Graphical Signature. 

♦ Validating a Signature – Validating signatures is the same whether you use a graphical 
image or not. Refer to Validating a Signature. 

♦ Removing a Signature – To remove a digital signature from an InfoPath form, refer to the 
first step in Clearing a Graphical Signature. 

Signing an InfoPath Form without a Graphical Signature 

After one or more sets of signable data are defined, a user can fill out a form and choose to 
sign any of these sets.  

To add a signature to a form: 

1. Open a form and fill the required fields. 

2. Click . The Digital Signatures dialog box pops up with a list of all the signatures in 
the form (if it is the first signature in the document the list is empty). 

3. Click Add. The first dialog of the signing wizard pops up, requesting you to select the part 
of the form you want to sign (Figure 64). Select a part and click Next. 
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Figure 64  Selecting the Part to be Signed 

4. Select the certificate you wish to sign with and click Next. 

5. Optionally type a comment that will be attached to the signature, and click Finish. 

6. Verify that the document looks as expected, then check I have verified this content 
before signing and click Sign. 

 

Note:  Steps 4 through 6 are similar to the steps taken when signing with a graphical 
signature. These steps are described in detail in Signing an InfoPath Form with a Graphical 
Signature. 
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Chapter 5: Signing Adobe Acrobat Documents 

The CoSign client enables you to digitally sign Adobe Acrobat documents using both Adobe 
Acrobat and Adobe Reader, as well as add your graphical signature to the PDF. This enables 
you to: 

♦ Easily sign an Acrobat document – The Acrobat document may contain multiple 
signatures, and each signature can be located in a different part of the document. It is also 
possible to generate several signatures for the same end-user. If a document is modified, 
the end-user is notified that the document was modified and is able to view the specific 
version of the document that was signed. 

♦ Certify an Acrobat document – Certification is more stringent than the regular signature 
operation. When a document is certified, it can be defined that no modification can be 
applied to the document (not even the addition of a new version to the document), or it can 
be defined that only certain fields in the document can be updated.  
Certification is available in Acrobat 6/7/8.  

♦ Validate the signature of an Acrobat document – Validation assures you that the 
document version that was signed was not modified after it was signed and that a trusted 
CA approves the user who performed the signature operation. 

The solution for Adobe 6/7/8 also does not require a client installation on the validator’s side. 

As part of the CoSign Web Services solution, the CoSign appliance provides a new Web 
Service mechanism called Adobe Roaming ID. This mechanism enables Adobe Acrobat 8 or 
Adobe Reader 8 to directly interface the CoSign appliance for digital signature operations, 
without requiring the installation of a CoSign client in the end user’s PC. This chapter provides 
instructions on how to setup Adobe Acrobat 8 and Adobe Reader 8 to directly use the CoSign 
appliance for digital signature operations.  
 

Note: Adobe Acrobat includes sophisticated mechanisms for handling digital signatures. 
These mechanisms enable you to maintain different versions of the Acrobat document, so that 
each digital signature actually signs a different version of the document. Be aware that even if 
the document is modified, older digital signatures will be validated against an older version of 
the document. 
 

Note: CoSign is currently compatible with versions 6.x, 7.x, and 8.x of Adobe Acrobat, and 
versions 6.x, 7.x, and 8.x of Adobe Reader. Refer to the Adobe documentation for complete 
information on Adobe’s digital signature capabilities. 

This chapter describes signing and validating an Acrobat Document using Adobe Acrobat 
6/7/8, as well as signing and validating signatures using Adobe Reader 6/7/8. 
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Signing an Acrobat Document using Adobe Acrobat 6/7/8 
 

Note:  CoSign supports Adobe 6, Adobe 7, and Adobe 8, but the dialog boxes shown in this 
chapter are Adobe 6 dialogs. They may differ slightly from the corresponding Adobe 7/8 
dialogs. 

Using Adobe Acrobat 6/7/8, you can generate and validate digital signatures. The following 
sections describe how to use the Acrobat 6 Windows Certificate Security and Acrobat 7/8 
Adobe Default Security signature handlers to set up, sign, and validate digital signatures, as 
well as certify Acrobat documents. They also describe how to sign and validate signatures 
using Adobe Reader 6/7/8. 

For each signature request, CoSign is activated for the purpose of signature operation only. 

Setting up Adobe Acrobat 6/7/8 to Use Digital Signatures  
 

Note: This setup procedure only needs to be performed once per workstation. 

To setup Acrobat to use digital signatures: 

1. Make sure a graphical image is stored in the local CoSign workstation. 

2. Make sure the Adobe Acrobat application is closed. 

3. Refer to Managing Graphical Signatures for instructions on how to import the CoSign 
based graphical images into the local Adobe installation in the end user’s PC. 

4. In Acrobat, select Edit  Preferences  General. The Acrobat Preferences dialog box 
appears. 
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Figure 65  Acrobat 6 Preferences Dialog Box 

5. Select the Digital Signatures option. The ARX Signature -<signature name> appearance 
appears selected in the Appearance box. 

6. In the Signing Method section, select Windows Certificate Security as the “Default 
Method to use when signing”.  

7. Click Advanced Preferences. The Digital Signatures Advanced Preferences dialog box 
appears with the Windows Integration tab selected. 
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Figure 66  Adobe Reader Advanced Preferences Dialog Box 

8. Check all the options in the Microsoft Windows Integration tab. 
9. Click OK to return to the Preferences dialog box. 

Using the Edit button, you can edit the appearance of the digital signature (refer to Editing the 
Signature’s Appearance). 
 

Note: Setting the Verify signatures when document is opened option automatically 
activates a validation procedure for all of the document’s digital signatures when the 
document is opened. The default is that digital signatures are not validated automatically 
when a document is opened. 

Editing the Signature’s Appearance 

You can configure the visual look of the digital signature by specifying the information to be 
presented in the digital signature location in the Adobe document. 

To edit the appearance of the signature: 

1. In the Preferences dialog box (Figure 65), select the relevant ARX Digital Signature 
appearance. 

2. Click Edit. The Configure Signature Appearance dialog box appears. 
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Figure 67  Adobe 6 Configure Signature Appearance Dialog Box 
3. In the Configure Graphic section, specify one of the following:  

♦ No graphic – No graphic will be displayed. 

♦ Imported graphic – The user’s graphic signature will be displayed with the signature.  
Avoid using the PDF file button for specifying which file to load, since the Update 
Acrobat option in the CoSign control panel loads the user’s graphic signature. 

♦ Name – Only the name of the signer will be displayed. 
4. In the Configure Text section, specify which text elements to include in the signature. 

5. Click OK to return to the Preferences dialog box. 

Signing an Adobe Acrobat Document – Acrobat 6/7/8 

To digitally sign an Acrobat document using Acrobat 6/7/8: 

1. In Acrobat, open the document you wish to sign. 

2. Click  and select Sign this document, or select Document  Digital Signatures 
 Sign this Document. 

The following alert pops up:  
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3. Specify whether to certify the document or sign the document. For information on 
document certification refer to Certifying an Adobe Acrobat Document – Acrobat 6/7/8. If 
you wish to sign, but not certify the document, click Continue Signing. 

4. If the document contains no signature fields, the following dialog box appears. 

 

Figure 68  Acrobat 6 Sign Document Dialog Box (signature fields do not exist) 

If the document already contains place holders for digital signatures, the following dialog 
box appears: 

 

Figure 69  Acrobat 6 Sign Document Dialog Box (signature fields exist) 

5. Select the Create a new signature field to sign option. 

You can alternatively choose to create a new invisible signature, which will have no 
visible representation in the document, or select an existing empty digital signature field. 

6. In the location where you want to add a signature, click and drag the cursor to create a 
rectangle on the screen.  

7. Click Next. The Digital ID Selection dialog box appears. 
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Figure 70  Acrobat 6 Digital ID Selection Dialog Box 

8. Select your certificate (even if you have a single certificate), and click OK 

The Apply Signature to Document dialog box appears. 



5 CoSign User Guide 

90 

 

Figure 71  Acrobat 6 Apply Signature to Document Dialog Box 

9. Enter the reason for the signature and other relevant details.  

10. In the Signature Appearance field, the ARX Digital Signature appearance is 
automatically selected. You can edit the appearance of the digital signature using the Edit 
button (refer to Editing the Signature’s Appearance). 

11. Click Sign and Save or Sign and Save As. 

The digital signature is placed in the designated location and appears as defined in the ARX 
Digital Signature appearance. 

 

Figure 72  Acrobat 6 Digital Signature Example 

If you have a graphical signature image (refer to Using the Graphical Signature Management 
Application), the graphical image appears next to the validation Image. 
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Figure 73  Acrobat 6 Graphical Signature Image 
 

Modifying a Signed Acrobat Document 

If you modify a signed document, all existing digital signatures are marked with a , to 
indicate that the signature is valid, but the document has been updated since it was signed. The 
digital signature matches an old version of the document that can be displayed. Following 
validation, the icon  indicating that the document was modified is displayed in the 
Signatures palette.  

Saving the document will mark all existing signatures with , to indicate that the digital 
signature needs to be validated when the document is opened. 

You can analyze the differences between the current document and the signed document using 
the Compare Signed Version to Current Document option (refer to Operations on 
Signatures in Adobe Acrobat 6/7/8 Documents). 

Operations on Signatures in Adobe Acrobat 6/7/8 Documents 

There are two ways to view and validate digital signatures: 

♦ In the location of the digital signature there is a validation image, which can be one of the 
following images:  

♦  – Signature is validated. 

♦  – Signature needs to be validated. 

♦  – Signature is not validated. 

♦ – Signer’s identity is unknown. 
 

Note: The image  can be combined with other images to indicate that the document has 
been updated since it was signed. 

♦ Using the Signatures palette on the left side of the Acrobat window (Figure 74). The 
window displays the existing digital signatures associated with the Acrobat document. 
Information is listed for each signature, including the name of the signer, signature date, 
and document revision. 

 



5 CoSign User Guide 

92 

 

Figure 74  Acrobat 6 Signature Palette 

The following digital-signature operations can be performed by right-clicking either the image 
of the digital signature or the digital-signature entry in the Signatures palette. 

♦ Clear Signature Field – Clears the digital signature but keeps the digital-signature field. 
This enables you to sign the document again and put the new digital signature in the 
original field. 

♦ Sign Signature Field – Enables you to digitally sign the Acrobat document in a location 
that previously contained a digital signature and was cleared using the Clear Signature 
option. 

♦ Delete Signature Field – Deletes an empty signature field. 

♦ Validate Signature – Performs a validation of the digital signature against the document 
information. A dialog box pops up, displaying the results of the signature validation. 

 

Figure 75  Acrobat 6 Signature Validation Status 
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♦ View Signed Version – If the document was modified after the digital signature was 
added,  will be added to the original signature image. The View Signed Version option 
enables you to view the actual document that was signed. 

♦ Compare Signed Version to Current Document – Displays the differences between the 
current document and the version of the document that was signed using this digital 
signature.  

♦ Go To Signature Field – Enables you to locate a digital signature in the Acrobat 
document. 

♦ Properties – Displays detailed information about the signature, including validity of the 
signature, Signer ID, Signature date and other details. 
Also, the certificate details of the signer can be viewed by clicking Show Certificate. 

 

Figure 76  Acrobat 6 Signature Properties Dialog Box 

Access the following options by clicking Options at the top of the Signatures palette: 

♦ Validate All Signatures – Checks all the signatures in the document and validates them. 
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♦ Clear all signature fields – Removes all digital signatures from the document and leaves 
only digital signature place holders. 

 

Note: By clicking a digital signature image, a validation action is executed. After a successful 
validation, √ is displayed. 

Certifying an Adobe Acrobat Document – Acrobat 6/7/8 

In Adobe 6/7/8 you can perform an operation called Document Certification, which is 
“stronger” than the regular signature operation: when a document is certified, you can define 
the following: 

♦ No modification can be applied to the document (not even the addition of a new version to 
the document). 

♦ Only remarks can be added to the base PDF document. 

During certification, the document is signed with your Private Key and Certificate. 

To certify a document: 

1. In Acrobat, open the document you wish to sign. 

2. Click  or select Document  Digital Signatures  Sign this Document. 

An alert pops-up: 

 

Figure 77  Acrobat 6 Document Certification Alert 

3. Click Certify Document.  

The Save as Certified Document – Choose Allowable Actions dialog box appears. 
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Figure 78  Acrobat 6 Selecting Certification Level 

4. In the Allowed Actions field, specify how stringent the certification should be. For 
example, you can specify that certification be irreversible (cannot be undone). 

5. Click Next. The regular digital signature dialog box appears. 

 

Figure 79  Adobe 6 Apply Signature to Certified Document Dialog Box 

6. Continue the process like any regular document signing process (refer to Signing an Adobe 
Acrobat Document – Acrobat 6/7/8). 



5 CoSign User Guide 

96 

When the process is completed, the certification image appears in the document: 

 
Figure 80  Acrobat 6 Certification Image Example 

 

Note: Only a file that is not signed can be certified, which means that a file that contains 
digital signatures can not be certified. 

Using the Update Acrobat Option in the Graphical Signatures Utility 

This option creates a new appearance called ARX Signature - <graphical signature name> into 
which it imports the user’s graphical digital signature. This enables Adobe Acrobat or Adobe 
Reader to incorporate CoSign graphical images in the Adobe graphical signature when a 
digital signature operation is activated. 

The utility is activated by first activating the Graphical Signature Management application, 
then selecting the name of the graphical signature you wish to use in Acrobat, and then 
clicking Update Acrobat (refer to Managing Graphical Signatures).  
This option is enabled only if the Graphical Signature Management application utility is 
working in user mode, in which the user can register his/her own graphical image. 

To edit the various settings of the ARX Digital Signature appearance, refer to Editing the 
Signature’s Appearance. 
 

Note: It is recommended to activate this option when Adobe applications are not running, to 
prevent file-sharing problems. 

Validating CoSign Signatures Using Adobe Reader 6/7/8 

Adobe Reader enables you to view and validate digital signatures in the document. 

No plug-in is necessary for the proper validation of an Adobe 6/7/8 document. 

To setup Adobe Reader 6/7/8 to validate signatures, perform the following once: 
1. Install the organization’s Root CA Certificate. Refer to Installing the ROOT Certificate. 

2. In Acrobat, select Edit  Preferences  General. The Acrobat Preferences dialog box 
appears. 

3. Click Advanced Preferences. The Digital Signature Advanced Preferences dialog box 
appears. 
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Figure 81  Acrobat 6 Advanced Preferences Dialog Box 

4. Check all the options in the Microsoft Windows Certificate Security section. 
5. Click OK to return to the Preferences dialog box. 
6. Click OK to exit the Preferences dialog box. 

The digital signatures appear inside the Acrobat document next to the validation symbol. If the 
digital signature contains a graphical signature, the graphical signature is displayed as well. 

When a document containing digital signatures is opened, a question mark is displayed next to 
each signature. After you validate the signature, the question mark symbol changes to a 
validated mark.  

The following digital-signature operations can be performed by right-clicking either the image 
of the digital signature or the digital-signature entry in the Signatures palette. 

♦ Validate Signature – Performs a validation of the digital signature against the document 
information. 

♦ Properties – Displays detailed information about the signature, including validity of the 
signature, signature date, user ID, signature creation date, certificate expiration, certificate 
issuer, and certificate details. 

♦ Go to Signature Field – Enables you to locate a digital signature in the Acrobat 
Document. 

♦ Validate all Signatures – Checks all the signatures in the document and validates them. 
This option can be viewed only from the Options button at the top of the Signatures 
palette. 
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♦ View Signed Version – Enables the user to view the exact version of the document that 
was signed. 

Note: Adobe Reader can be configured to automatically validate digital signatures on opening 
a document by setting the Verify signatures when document is opened option. Refer to 
Setting up Adobe Acrobat 6/7/8 to Use Digital Signatures. 

Signing an Acrobat Document Using Adobe Reader 6/7/8 

You can also perform signature operations using Adobe Reader version 6/7/8. However, you 
need to use specially formatted Acrobat files that already contain signature fields. Once you 
locate a signature field in the document, you can perform the digital-signature action.  

Once you select the digital signature box, the signing process is similar to the signing process 
using Adobe Acrobat (refer to Signing an Adobe Acrobat Document – Acrobat 6/7/8). 

Signing a PDF document Without Using Adobe Acrobat  

To sign PDF files without installing Adobe Acrobat, you can use either OmniSign (refer to 
Chapter 6: OmniSign – Sign Any Printable Data, Anywhere) or the arfilesign.exe utility 
(refer to Chapter 7: The ARFileSign Utility). 

Signing in Adobe Acrobat/Reader 8 Using Adobe Roaming ID 

In Adobe Reader 8 and Adobe Acrobat 8, Adobe introduces a new digital signature mechanism 
called roaming ID that is based on Web Services. This mechanism enables you to digitally sign 
PDF documents without installing any software in the client PC. 
Adobe Reader and Adobe Acrobat can interface the CoSign appliance through a Web Service 
interface. The roaming ID mechanism requires a user to authenticate to the CoSign appliance 
based on a user name and password and perform a digital signature operation using the user’s 
signature key inside the CoSign appliance. 

You can use roaming ID in any of the following modes: 

• User generates a roaming ID profile – In this mode, the PDF document contains a 
signature field that does not include a roaming ID profile. You must define a roaming ID 
profile in advance, and use it during the digital signature operation. Refer to Generating a 
Roaming ID Profile. 

• Signature field already contains a URL – In this mode, the PDF document contains a 
signature field which already includes the URL of the CoSign appliance that will enable 
the end user to invoke the digital signature Web Service in Adobe. In this mode, the end 
user needs only to perform a digital signature operation. Refer to Signing a Signature Field 
that Contains a URL . 
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Generating a Roaming ID Profile 

To define a roaming ID profile: 
1. In Adobe Reader, select Document > Security Settings. The Security Settings dialog box 

appears. 

 

Figure 82  Security Setting Dialog Box 

2. Select Roaming ID Accounts in the left pane of the Security Settings dialog box. 

3. Click Add Account. The Add a Roaming ID dialog box appears. 
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Figure 83  Add a Roaming ID Dialog Box – Entering a Name and URL 

4. Enter the following information: 

♦ Name – Enter a name such as CoSign. 

♦ URL – Enter a value such as https://cosign:8080/SAPIWS/assp.asmx. 
 

Note:  By default, the CoSign appliance is distributed with a temporary SSL certificate called 
cosign. You can generate your own SSL Server Certificate and name it with CoSign’s DNS  
name; for example, cosign.company.com). 
If you would like use the CoSign temporary certificate, define an entry named cosign in your 
local hosts file, and specify the IP address of the CoSign appliance. The local hosts file is 
located in /etc/hosts in Unix platforms, and in 
Windows\System32\drivers\etc\hosts in Windows platforms. 
 

Note: If you enroll for an SSL Server certificate, refer to the Managing the CoSign Appliance 
chapter in the CoSign Administrator Guide for instructions on how to upload the SSL Server 
certificate to the CoSign appliance. 

5. Click Next. In the window that appears, enter a user ID and a password for authenticating 
to the CoSign appliance. 
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Figure 84  Add a Roaming ID Dialog Box – Entering a User Name and Password 

6. Click Next. The final window appears, displaying the roaming ID settings, including the 
date when the User’s certificate expires: 
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Figure 85  Add a Roaming ID Dialog Box – Displaying Roaming ID Information 

7. Click Finish.  

The selected certificate will be listed in any subsequent digital signature operation. If you 
choose this certificate, Adobe Reader/Adobe Acrobat will access the CoSign appliance for the 
digital signature operations. During this attempt, the user will be requested to supply a User ID 
and a password. The signature field that appears when using a roaming ID is identical to a 
regular signature field. 
 

Note: The Roaming ID mechanism does not automatically support a graphical signature. To 
use a graphical signature, you must manually insert a graphical signature in Adobe 
Reader/Adobe Acrobat using the Appearance mechanism. 

Signing a Signature Field that Contains a URL  

If the user initiates a digital signature operation and the signature field already contains a URL 
for accessing the CoSign appliance, the user is requested to enter a User name and a password 
for accessing the CoSign appliance. This act will generate a roaming ID profile for the user, 
which the user can use for all subsequent signing operations.  

To sign a signature field that includes a URL: 

1. When you initiate a digital signature operation and the signature field already contains a 
roaming ID profile, the following window appears. 
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Figure 86  Sign Document Dialog Box – Displaying Roaming ID Information 

2. Select the username from the Digital ID drop-down list. 

3. Select the appearance of the signature in the Appearance drop-down list. If you select an 
appearance that contains a graphical image, this graphical signature will be included in the 
digital signature.  

4. Click Sign. A dialog box appears, requesting a password. 

5. Enter the password corresponding to the username you selected. 

Validating the digital signature is similar to validating a regular digital signature. Refer to 
Validating CoSign Signatures Using Adobe Reader 6/7/8 for more information. 
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Chapter 6: OmniSign – Sign Any Printable Data, 
Anywhere 

This chapter describes how to use OmniSign to sign any printable data from any application. 

Overview of OmniSign 

OmniSign enables you to sign any printable data from any application. OmniSign serves as a 
“virtual digital signature printer” to which files are sent, and from which they return converted 
into a signed PDF file. 

The major benefits offered by OmniSign include: 

♦ Sign any document by using the document’s application File > Print command. 
While CoSign comes with extensive third party application support for digital signatures, 
there are other applications that do not provide digital signatures support such as ERP 
systems, homegrown systems, and others.  
With OmniSign, any of these applications that support standard printing functionality can 
utilize OmniSign to add digital signatures to their documents. 

♦ Sign existing PDF files without the need for expensive solutions, such as Adobe Acrobat 
Professional. 

Before signing a file, you can set the size, location, and other attributes of the signature field. 
In addition, you can perform batch signing of files, run OmniSign in silent mode, and control 
the various signing parameters to best fit your needs. 

The signing process consists of:  

♦ Converting the file to PDF format. Refer to Printing the File. 

♦ Signing the PDF file. Refer to The Signing Process. 

Starting from CoSign client version 4.3 there is an option to incorporate an electronic signature 
into the PDF document. An electronic signature is a graphical image of an end-user’s 
handwritten signature. The end-user can enter his/her electronic signature using a graphical 
signature pad. This mode is very suitable for product purchase at a Point Of Sale. In this type 
of application, after the purchase form is filled, the customer inserts his/her electronic 
signature, and the local sales person digitally signs the whole document. 
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Printing the File 

Signing any file format using OmniSign always starts with printing the file from within the 
file’s application (unless the file is already in PDF format).  

To print the file: 

1. Open the file in its application. 

2. Select File > Print. The Print dialog box pops up. Figure 87 displays the standard Print 
dialog box that appears in Word. 

3. Select ARX CoSign OmniSign Printer as the printer. 

 

Figure 87 Selecting the ARX CoSign OmniSign Printer 

4. Change the print properties if desired. 

5. Click Print. 

Clicking OK triggers the PDF conversion process, during which a temporary file is created in 
the Windows Temp folder with the file name derived from the printing job name. The file 
content is then converted to PDF format and the OmniSign application is launched for the 
newly created PDF file, enabling you to sign the file (see The Signing Process).  
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The Signing Process 

The OmniSign window is used for viewing a PDF file, specifying the signature field location 
and size, signing the file, and optionally performing an additional post signing action. This 
process is controlled by the various parameters you can configure in the OmniSign window.  

You can optionally add several electronic signatures prior to performing the digital signature 
operation. An electronic signature is a graphical image of an end-user’s handwritten signature. 
Note that an electronic signature is only an image embedded into the document, and does not 
protect the document.  

Among the settings you can configure are: 

♦ Signature location (for either electronic or digital signatures) 

♦ Signature width and height (for either electronic or digital signatures) 

♦ Signature appearance (including invisible signature mode) 

♦ The reason for signing  

♦ Post signing action 

♦ File saving options 

♦ Silent mode 

♦ Zoom  

Accessing OmniSign and Saving Settings 

You can access OmniSign in either of the following ways: 

♦ Regular usage – Running OmniSign to sign a specific document. This is done by either: 

♦ Printing any file using the ARX CoSign OmniSign printer. 

♦ Right-clicking a PDF file and selecting Sign from the pop-up menu. 
In both cases, the OmniSign window appears (Figure 88), with the PDF file visible in the 
preview pane and a signature space holder in focus if the Show Signature Field option is 
checked. You can edit any of the OmniSign settings, and when you click Sign to sign the 
file, your settings are saved for future execution. Clicking Close exits the application 
without saving any changes. 

♦ Setup purposes – Running OmniSign from the CoSign Control Panel. In this method, no 
file is being signed. From the Start menu select Programs  ARX CoSign  CoSign 
Control Panel. In the CoSign Control Panel select OmniSign Settings and the OmniSign 
window appears but with no file visible in the preview pane. You can edit any of the 
OmniSign settings, and then click OK to close the application and save your settings for 
future execution. Clicking Cancel exits the application without saving any changes.  
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Figure 88  OmniSign Window - Signature Settings tab 

The OmniSign window enables you to perform the following: 

♦ Sign the document – Refer to Performing the Digital Signature Operation. Note that you 
can perform an electronic signature prior to performing the digital signature (refer to 
Performing an Electronic Signature Operation). 

♦ Configure general signature settings – Refer to Configuring the Signature Settings. 

♦ Configure advanced settings – Refer to Configuring the Save Options. 

♦ Set file zoom and size – Refer to Setting the Zoom and Size. 

♦ Restore the default settings – Refer to Restoring Default Settings. 
 

Note:  Starting from version 4.3 you can minimize the Settings panel by clicking the 
Hide/Show Settings button. To restore the Settings panel, click the Hide/Show Settings 
button again. 

Performing an Electronic Signature Operation 

If you wish to view or change any OmniSign settings before signing, refer to Configuring the 
Signature Settings, Configuring the Save Options, and Setting the Zoom and Size. 
 

Note: Make sure that the Allow Electronic Signatures option is set in the Signature tab, 
accessed by editing the Profiles list as described in OmniSign – Profiles. 
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When you finish setting all desired signing and saving parameters, you can perform the 
electronic signing operation by setting Signature Type to Electronic and clicking Sign in the 
OmniSign window (Figure 88). 
It is required to attach a pad to the workstation (refer to Chapter 2: Deploying the CoSign 
Client for more information on which pads can be used). It is also required that the CoSign 
client be installed with the ARX CoSign admin component which enables using a signature 
pad. 

Clicking Sign performs the following:  

1. All settings that were changed by the user are stored for future execution. 

2. The end user is prompted to enter a signature using the currently connected signature pad. 

If the pad includes a display, the graphical signature appears on both the display and the 
PC. 

 

Figure 6-89  Electronic Signing using a Signature Pad 

3. A new electronic signature image is created according to the signature field settings. 

You can add an electronic signature several times before digitally signing the PDF document. 

Performing the Digital Signature Operation 

If you wish to view or change any OmniSign settings before signing, refer to Configuring the 
Signature Settings, Configuring the Save Options, and Setting the Zoom and Size. 

When you finish setting all desired signing and saving parameters, you can perform the signing 
operation by setting Signature Type to Digital and clicking Sign in the OmniSign window 
(Figure 88). 

Clicking Sign performs the following: 

1. All settings that were changed by the user are stored for future execution. 

2. A new signature field is created according to the signature field settings. 

3. A signing certificate is chosen. If there is a single certificate it is automatically chosen. 
Otherwise, a Select Certificate dialog box pops up for selecting the desired certificate 
from the certificates list. 
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4. If the end user has more than one graphical image inside CoSign, and you specify that the 
graphical image is part of the signature, a graphical signature selection dialog box pops up. 
After selecting the desired graphical image click OK. 

5. The document is signed. 

6. If no post-signing operation is defined, the OmniSign application closes. 
If a post signing operation is set, it is executed right after the document is signed. If either 
Open Signed Document or Email Signed Document were specified, the relevant 
application is launched and OmniSign closes without waiting for the post signing 
operation to complete. 

Note: If OmniSign settings were changed, clicking Sign stores the new settings even if the 
signing operation fails for any reason. 

Note: When the digital signature is viewed using Adobe Acrobat 6/7/8 or Acrobat Reader 
6/7/8, a message displays to inform you that the time stamping of the digital signature is taken 
from the local computer, even though the actual time is taken from the CoSign appliance. 

Configuring the Signature Settings 

The Signature settings tab contains the common parameters that influence the signature 
appearance and the behavior of the application. It includes parameters for the following: 

♦ Configuring the Signature Appearance. 

♦ Configuring a Post Signing Action. 

♦ Configuring the Signature Field Size and Position. 

Configuring the Signature Appearance 

 

Figure 90  Signature Appearance 

The Signature Appearance includes the following parameters: 

♦ Show signature field – Indicates whether the signature field will be visible. When this 
box is unchecked, the signature appearance and the signature size and position settings are 
disabled, and the signature rectangle (shown in Figure 88) is hidden.  

 

 



OmniSign – Sign Any Printable Data, Anywhere 6 

 111 

♦ Display caption (labels) – Indicates whether to use captions such as Date, Reason, Signed 
by, for the fields that will be displayed in the signature field. 

♦ Graphical signature – Indicates whether the graphical signature (if it exists in CoSign) 
will be displayed in the signature field. 

♦ Date & time – Indicates whether the date and time of signing will be displayed in the 
signature field. 

♦ Signer’s name – Indicates whether the signer’s name will be displayed in the signature 
field. If this box is not checked but there is no graphical image in CoSign, this setting will 
be overridden and the signer’s name will be displayed in the signature field. 

♦ Reason – Indicates whether the reason for signing will be displayed in the signature field. 

♦ Reason for signing – The reason that is attached to the signature field and can be seen in 
the signature pane when the file is opened with Adobe Reader. If the Reason box is 
checked, the reason is also displayed in the signature field on the document itself. You can 
select a reason from the list or enter a new one. The list is defined in the OmniSign section 
of the CoSign client configuration utility. Refer to Setting OmniSign Configuration. 

♦ Additional Text – Indicates whether there will be additional text displayed in the signature 
field. You can display the title of the signer in this text.  

♦ Additional Text value – The actual text of the additional text will be put in this text field. 

Configuring a Post Signing Action 

 

Figure 91  Signature Post Action  

Post-signing actions are actions that are performed on the signed file immediately after it is 
signed. You can select one action at most. The OmniSign application does not wait for the 
action to terminate, but launches it and exits, except in the case of Leave OmniSign Open. 
The Signature Post Actions include: 

♦ Open signed document – Opens the signed file with the PDF file type associated 
application (usually, Adobe Reader). 

♦ Email signed document – Opens a new mail message with the signed file already 
attached, and the subject being the signed file name. 

♦ Leave OmniSign open – Reopens the signed file in OmniSign and does not close the 
application. 

♦ Print document – Sends the document to the printer after it is signed. 
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Configuring the Signature Field Size and Position 

You can specify the signature field’s size and position in either of two ways: 

♦ Browse the document inside the OmniSign window and use the mouse to specify a 
rectangle for the signature field. The values in the Signature size & position fields are 
automatically updated accordingly. 

♦ Manually enter the values in the Signature size & position section. The parameters in the 
section include: 

 

Figure 92  Signature Size & Position 

♦ Page – Specifies the page in which to create the signature field. The available options 
are First page, Last page, and Specify Number. When Specify Number is selected, 
enter the page number in the Number field. 

♦ X – The horizontal distance in Adobe pixel units of the signature field’s bottom left 
corner from the document’s {0, 0} point, usually (but not always) the bottom left 
corner of the document. 

♦ Y – The vertical distance in Adobe pixel units of the signature field’s bottom left 
corner from the document’s {0, 0} point, usually (but not always) the bottom left 
corner of the document. 

♦ Number – The page where the signature field is added. This field is visible only when 
Page is set to Specify Number. 

♦ Width – The width in Adobe pixel units of the signature field. 

♦ Height – The height in Adobe pixel units of the signature field. 
 

Note: Any change in the Signature size & position parameters immediately affects the location 
and size of the signature rectangle displayed in the view pane of the OmniSign window. 

 
Note: Different settings are kept for digital signatures and electronic signatures. 

Configuring Advanced Settings 

In the advanced settings tab you can:  

♦ Configure the date and time format – Refer to Configuring Date and Time Format. 

♦ Configure the Save settings – Refer to Configuring the Save Options. 

♦ Configure additional settings – Refer to Configuring Additional OmniSign Parameters. 
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Configuring Date and Time Format 

If the date and time are displayed in the signature field (that is, the Date & Time box is 
checked in the Signature Appearance), you can set the date and time format as follows: 

 

Figure 93  Date & Time Format 

♦ Date – The date format. You can select a format from the drop-down list or create a new 
one. See Figure 36 for an explanation of the date format notation. 

♦ Time – The time format. You can select a format from the drop-down list or create a new 
one. See Figure 36 for an explanation of the time format notation. 

♦ Display GMT offset – Indicates whether to display the time zone of the signature 
operation in relation to GMT. 

 

Note: You can modify the format of the date and time strings so that the displayed date and 
time contain some additional fixed text. Take care not to change the letters that identify the 
year (y), month (m), day (d), hour (h), and minutes (m), even if these letters are different in 
your native language. 

Configuring the Save Options 

 

Figure 94  Saving Options 

The following file save options are available: 

♦ Default folder – Specifies the folder where the signed PDF file will be stored. The value 
of this field is ignored in the following cases: 

♦ If the field is empty. 

♦ If Always ask where to save is checked, and OmniSign is not running in silent mode. 

 
Note:  The Default Folder field is used to specify only the folder name, while 
the file name itself is taken from the printing job name. In order to set both the 
folder and file names, check the Always Ask Where To Save box and enter 
both the folder and file names in the Save As dialog box that will pop up. 
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♦ Always ask where to save – If this box is checked and OmniSign is not running in silent 
mode, a Save As dialog pops up after you click Sign, enabling you to specify where to 
store the signed file. 

 

Note: If you do not specify a destination for the signed file, OmniSign will overwrite the source 
PDF file with the signed PDF file. 

♦ Delete original – This option is available only when signing existing PDF files, and it 
indicates whether to delete the source PDF file.  

♦ Delete intermediate file – This option appears when OmniSign was launched by a 
printing job. It is always set to true to indicate that the intermediate PDF file will be 
deleted. If no default folder is defined, OmniSign automatically checks Always ask where 
to save. 

Configuring Additional OmniSign Parameters 

 

Figure 95  Additional OmniSign Parameters 

You can configure the following additional OmniSign configuration parameters: 

♦ One-touch signature positioning – If this option is selected, a digital signature field 
appears with a fixed width and height, based on the current width and height. This 
functionality is useful for cases where there are fixed sized signature fields, and the user 
need not set the size of the signature every time he/she wishes to sign. 

♦ Continuous scrolling – If this option is selected, the whole PDF document is displayed in 
the left pane and you can scroll through the whole document. If this mode is not selected, 
you can see one page at a time.  

♦ Show settings – If this option is not selected, you will not be able to view the whole 
parameters section (right pane). This is useful for cases in which you do not want the user 
to modify parameters accidentally. To turn this parameter back on, select OmniSign 
Settings in the CoSign Control Panel. 

♦ Run in Silent Mode – OmniSign can run either in GUI mode or in silent mode, as 
follows:  

♦ In GUI mode, the OmniSign window (Figure 88) is visible, and you can view the PDF 
file, change settings if desired, and then you must click Sign to perform the signing 
operation.  

OmniSign features that can be used only when running in GUI mode are those that 
require user interaction; that is, they cause a dialog box to pop up. These include: 

♦ Working with more than one certificate in the store, since it causes a Select 
Certificate dialog box to pop up. If OmniSign is run in silent mode and more than 
one certificate is available, the operation fails. 
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♦ The Always Ask Where To Save feature. In silent mode this value is ignored. 

♦ In silent mode, the OmniSign window does not appear. Whether you print a file using 
the ARX CoSign OmniSign printer and click OK, or right click a PDF and select Sign, 
no interface is visible. OmniSign runs silently in the background, with the settings that 
were set the last time OmniSign was run with a GUI. 

Only silent mode offers the advantage of running OmniSign for multiple files using 
wildcards (such as c:\tmp\*.pdf). 

To turn off Silent mode, activate the CoSign Control Panel by running  
Start  Programs  ARX CoSign  CoSign Control Panel. Activate the OmniSign 
Settings application and then uncheck Run in Silent Mode in the Advanced tab. 

About OmniSign Tab 

The About OmniSign tab displays information about the current OmniSign version and a link 
to ARX web site. 

Setting the Zoom and Size  

You can set the following in the OmniSign window: 

♦ Zoom – Specify the zoom setting by selecting an option from the drop-down list. The view 
of the file is automatically adjusted. 

♦ Size – You can change the OmniSign application window size using either the 
maximize/restore button or by dragging the application’s frame. The preview pane’s size 
changes accordingly. Note that there is a minimum height and width. 

Restoring Default Settings 

OmniSign stores parameter values changed by the user, under the Current User settings in the 
registry. If you wish to restore default settings, click Restore defaults (see Figure 88). 

When you click Restore defaults, OmniSign performs the following: 

1. Removes all user-defined values from the registry.  
If no value is then defined under the user registry for a certain parameter, OmniSign looks 
for this value in the local machine definitions (refer to Setting OmniSign Configuration for 
more details). If no value is found, it uses a default value. 

2. Immediately updates the values in its dialog boxes. These settings apply whether you click 
Sign or Cancel. 
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Signing Existing PDF Files 

The OmniSign application can be used to sign existing PDF files without installing and 
running Adobe Acrobat. 

To sign a PDF file using OmniSign: 

1. Run Windows Explorer. 

2. Right click the PDF file you wish to sign. 

3. Select Sign from the pop-up menu. The OmniSign window appears for the desired file. 

4. Set the signature settings as desired, and click Sign. 

Batch Signing 

The OmniSign application can also be used for signing multiple files in unattended mode.  

To run OmniSign for batch signing: 

1. Run Start  Programs  ARX CoSign  CoSign Control Panel. In the CoSign 
Control Panel select OmniSign settings. The OmniSign window appears. 

2. Configure the signature settings you wish to apply to all the files to be signed. 

3. Turn on silent mode by checking the Run in Silent Mode box in the Advanced Settings 
group of the OmniSign window. 

4. If you want the signed files to be stored in a different folder than the one they are stored in 
before signing, specify the folder in the Default folder field (Figure 94). 

5. Click OK to close the OmniSign window. 

6. Run one or more instances of OmniSign.exe (either in parallel or serialized) with a 
single parameter that represents a group of files using wildcards (such as c:\tmp\*.pdf). 
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Chapter 7: The ARFileSign Utility 

One of the CoSign client components is SAPI. This component enables programmers to 
digitally sign any PDF, Tiff, Word/Excel 2007, or Word 2003 file. For more information about 
SAPI, see the CoSign Programmer Guide (SAPI). You can also use the arfilesign.exe 
command line utility to sign those file types. 

This chapter describes the arfilesign.exe utility. Keep in mind that the arfilesign.exe 
utility is your only option for signing Tiff files when code development is not an option. 

Overview 

The arfilesign.exe command-line utility is installed under 
Program Files\ARX\ARX Signature API. This utility enables you to sign and validate 
signatures of Tiff\PDF\Office 2007\Word 2003 files. 

The arfilesign.exe utility signs a document in automatic batch processing, without 
requiring you to open MS Word or Adobe Acrobat and to sign the documents manually. The 
utility accepts a file name and a set of options, and performs a signature operation on the file. 

Signing multiple files is possible by providing a wildcard pattern rather than a single file name. 

The arfilesign.exe utility can be used for other operations, such as creating a signature 
field or performing verification. 

Signing TIFF Files 

The Cosign client supports digital signatures in Tiff documents. This enables you to: 

♦ Easily sign a Tiff document. The signature operation optionally attaches a first page that 
includes the signer’s name, the signature date, and the text “Powered By CoSign”. 

♦ Validate the signature on a Tiff document. Validation assures you that the document was 
not modified after it was signed, and that a trusted CA approves the signer. 

Using ARFileSign for Tiff Files 

Note the following when using arfilesign.exe for Tiff Files: 

♦ You can have multiple non visible signatures in a TIFF file, or you can define the first 
signature as Visible, and the rest as Non Visible. 

♦ The signature operation optionally attaches a first page that includes the signer’s name, the 
signature date, and the text “Powered By CoSign”. 
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♦ The digital signature is embedded inside a special Tiff tag whose identity number is 
50685. 

Signing Other Files 

Using ARFileSign for Adobe Files 

The signatures performed by the arfilesign.exe utility upon a PDF file are compatible 
with Adobe 6/7/8 (Acrobat and Reader). You can therefore validate the signatures using Adobe 
6/7/8 (Acrobat and Reader). 

If you wish to sign a PDF file, it is not necessary to have any Adobe product installed on the 
machine running the arfilesign.exe utility. 

Using ARFileSign for Word 2003 Files 

If you wish to sign a Word file, you must have Microsoft Word installed in the machine that is 
running the arfilesign.exe utility. 

To sign Word files, contact ARX for additional directions. 

Using ARFileSign for Word/Excel 2007 Files 

If you wish to sign a Word /Excel 2007 file, it is not necessary to install Office 2007 on the 
client machine. However, you must have .NET framework version 3 installed on the client 
machine. 

Note that only the signing or clearing of existing fields is supported. To create a digital 
signature field, you must therefore use Office 2007 with either the Microsoft Signature Line 
provider or the ARX Signature Line Provider. 

Office 2007 files are marked as OXMLP (Office Xml Package). 
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Executing arfilesign.exe 

The arfilesign.exe utility is executed as follows: 

arfilesign.exe –fn <file-name> [options] 

where file-name is the name of the file on which the signature field operation is performed. 
To sign multiple files, provide a file mask instead of a file name (for example, C:\*.tif). 

The arfilesign.exe options 

♦ [-op <operation number>] – Supply one of the following numbers to indicate the 
required operation: 

1 Create field 
2 Sign field (creates a field if needed) 
3 Verify field 
4 Clear field 
5 Remove field 
6 List fields 
7 Create a field and Sign it in one operation 

The default operation number is 2. 
♦ [-ft <file type>] – Indicate one of the following file types: doc, OXMLP, pdf or tif. 

The default value is set according to the file extension.  

♦ [-v <Visible/Invisible>] – Visible or Invisible signatures (default: Visible). In the 
case of a Tiff file, specify whether the signature is Visible or Non Visible. In a Tiff file 
only the first digital signature may be Visible. 

♦ [-p <page number>] – The number of the page in which the signature field will be 
created (default: 1). If –1 is provided, the signature is placed on the last page. This option 
is not available for Tiff files. 

♦ [-x <x coordinate>] – The signature field's left x coordinate (default: 100). This 
option is not available for Tiff files. 

♦ [-y <y coordinate>] – The signature field's bottom y coordinate (default: 100). This 
option is not available for Tiff files. 

♦ [-w <width>] – The width of the signature field (default: 200). This option is not 
available for Tiff files. 

♦ [-h <height>] – The height of the signature field (default: 100). This option is not 
available for Tiff files. 

♦ [-sff <flags value>] – Reserved. Do not use this flag. 

♦ [-r <reason text>] – The reason for signing, or the reason label when creating fields. 

♦ [-sfi <field index>] – The signature field index. If -sfi is not provided, the first 
field that matches the operation is used. This parameter is not available for Tiff files. 
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♦ [-sfn < field name>] – The signature field name (an alternative to -sfi). If -sfn is 
not provided, the first field that matches the operation is used. This parameter is not 
available for Tiff files. 

♦ [-ser <certificate serial number>] – The certificate serial number. The utility 
will use this certificate and its relevant Private Key for the digital signature operation. 

♦ [-grn <graphical signature name>] – The utility uses the specified graphical 
image for the digital signature operation. 
If the user has more than one graphical image and this option is not used, there will be no 
graphical image in the Tiff signature. 

♦ [-d <dependency mode>] – Dependent or Independent Signature (default: 
Independent). For Tiff files this parameter must be defined as Dependent. 

♦ [-am <appearance mask>] – Defines the fields that will appear in the digital signature 
box (default: Image, Name, Time). Combine any of the following: Image, Name, Time, 
Reason, separated by commas, or use the value: None. This parameter is not available for 
Tiff files. 

♦ [-lm <labels mask>] – Defines whether a label will be presented in the digital 
signature (default: None). Combine any of the following: Name, Time, Reason, separated 
by commas, or use the value: None. 

♦ [-tf <time format>] – Time format of the displayed signature (default: "h:mm tt"). 
For all possible values see the time formats in the screen capture appearing in Signature 
Default Settings – Date and Time Format. 

♦ [-df <date format>] – Date format of the displayed signature (default: "MMM d 
yyyy"). For all possible values see the date formats in the screen capture appearing in 
Signature Default Settings – Date and Time Format. 

♦ [-to < time offset>] – Whether to show signature time offset: GMT or None 
(default: None). 

♦ [-c] – Certificate chain flags. If this parameter is set, the digital signature will contain all 
certificates until the ROOT certificate, inclusive. 

♦ [-cfg] – For further information on using this parameter, please refer to the CoSign 
Programmer Guide (SAPI) or contact ARX. 

♦ [-flg] – For further information on using this parameter, please refer to the CoSign 
Programmer Guide (SAPI) or contact ARX. 

♦ [-uid] – The user ID of the user performing the signature operation. 

♦ [-pwd] – The password of the user performing the signature operation. 

♦ [-dom] –The Active Directory or Novell NDS domain of the user performing the 
signature operation. 

♦ [-pfs] – The Prompt For Sign password in cases where it is required. Note that if the 
password is identical to the one supplied in [-pwd] then it is not required. 

♦ [-cf] – Additional custom fields. These fields enable you to attach additional information 
to a newly generated field. Each custom field contains an ID, type, and value. The 
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available types include, for example, 1 – integer, 2 – string. For a full description refer to 
the SAPI Programmer Guide. 
Format the input as follows: 
<ID1>,<Type1>,<value1>,<ID2>,<Type2>,<Value2>,… 
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Chapter 8: Signing WordPerfect Documents 

The CoSign client supports digital signatures in WordPerfect documents. This enables you to: 

♦ Easily sign a WordPerfect document. 

 
Note: A WordPerfect document can only contain one signature. 

 
Note: Any attempt to sign a previously signed document erases the previous 
digital signature. A digital signature is also erased if the document is modified. 

♦ Validate the signature on a WordPerfect document – Validation assures you that the 
document was not modified after it was signed, and that the signer is approved by a trusted 
CA. 

This chapter describes how to generate and validate digital signatures using WordPerfect.  

Signing a WordPerfect Document 

To digitally sign a WordPerfect document: 

1. In WordPerfect, open the document you wish to sign. 

2. Open the File menu and select Signature  Sign Document. The Sign Document dialog 
box appears (Figure 96). 

 

Figure 96  Sign Document Dialog Box 

3. Select the desired certificate from the drop-down list. The certificate is marked with a .  

4. To view more information about the selected certificate, click View. The Certificate dialog 
box appears. The Information tab displays the contents of the certificate, including the CA 
Name of the CoSign appliance that issued the certificate, the certificate’s period of 
validity, and whether the certificate is currently valid.  
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Figure 97  Certificate Dialog Box – Information Tab 

5. Select the Validation tab. 

 

Figure 98  Certificate Dialog Box – Validation Tab 

6. Select any of the following certificate validation options: 

♦ Check the Certificate Authority (Using the Internet) – Checks the CRL of the 
certificate authority. 

♦ Check parent certificates – Checks the chain of certificates from the end user 
certificate to the root certificate. 
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♦ Check root certificate – Checks the root certificate. 

 
Note: For more information on WordPerfect validation options, refer to 
http://Corel.com. 

7. Click OK to save your changes or Cancel to return to the Sign Document dialog box. 

8. In the Sign Document dialog box, click OK to digitally sign the WordPerfect document 
with the selected certificate. 

 

Note: When you add a digital signature to a WordPerfect document, the document is not 
automatically saved. Make sure to save the document after adding your signature, since the 
save operation will actually create the signature. 
 

Note: The current version of CoSign does not support graphical signatures in WordPerfect 
documents. 

Modifying a Signed WordPerfect Document 

Once a document is signed, you cannot modify the document without deleting the signature. If 
you modify a signed document, you must sign the document again.  

Validating Signatures in WordPerfect Documents 

To validate a signature attached to a document: 

1. Open the document in WordPerfect. 

2. Open the File menu and select Signature  View Signature. The Digital Signature 
dialog box appears. 

 

Figure 99  Digital Signature Dialog Box – Valid Signature 

This dialog box indicates if there is any problem with the digital signature or the 
certificate. If the certificate is not trusted, the Digital Signature dialog box may appear as 
follows: 

 

 

http://www.corel.com/servlet/Satellite?pagename=Corel/Home
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Figure 100  Digital Signature Dialog Box – Certificate Not Trusted 

3. Click View Certificate to view more information about the certificate. The Certificate 
dialog box appears (refer to Figure 97 and Figure 98). 

Viewing Details about Invalid Signatures 

If someone tampered with the document after the document was signed, the following message 
appears upon opening the document: 

 

Figure 101  Digital Signature Warning Dialog Box 

To view details about the invalid signature: 

♦ Click Details.  

The Digital Signature dialog box appears, displaying information about the invalid 
signature.  

Validating CoSign Signatures without CoSign 

If you are not using CoSign, you can still validate signatures that were attached using CoSign. 
This is useful if you receive documents from a company or organization that uses CoSign 
internally.  

To validate signatures without using CoSign: 

1. Obtain the ROOT CA Certificate from a reliable representative of the organization using 
CoSign. 

2. Install the organization’s ROOT CA Certificate (refer to Installing the ROOT Certificate). 

3. Validate the signature. Refer to Validating Signatures in WordPerfect Documents.  
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Chapter 9: Signing Outlook Emails 

This chapter describes how to generate and validate digital signatures using Microsoft Outlook 
and Microsoft Outlook Express.  

Signing Outlook Emails 

Microsoft Outlook includes tools for sending and receiving digitally signed emails. CoSign 
integrates with Outlook by managing your public and private keys and certificates. This 
enables you to easily sign emails in Outlook. 

Before you can send signed email messages, you must configure Outlook to associate your 
certificate with your email account.  
 

Note: The procedures described in this section refer to Microsoft Office 2000. Dialog boxes 
and other user interface elements may appear slightly different in Microsoft Office XP/Office 
2003/Office 2007. 

Configuring Outlook 

To configure Outlook to work with CoSign: 

1. Open Outlook. 

2. Open the Tools menu and select Options. The Options dialog box appears. 
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3. Select the Security tab. 

 

Figure 102  Options – Security 



Signing Outlook Emails 9 

 129 

4. For additional settings options, click Change Settings. The Change Security Settings 
dialog box appears.  

 

Figure 103  Change Security Settings 

5. In the Certificates and Algorithms section, click Choose to select a signing certificate. The 
Select Certificate dialog box appears.  

6. Select the certificate you want to use for signing your emails, and click OK. You are 
returned to the Security tab of the Options dialog box. 

7. To automatically sign all outgoing messages, check Add digital signature to outgoing 
messages on the Security tab of the Options dialog box. 

8. Click OK. 

Sending Signed Email Messages 

To sign all your email messages: 

1. In Outlook, open the Tools menu and select Options. The Options dialog box appears 
(Figure 102). 

2. Select the Security tab. 

3. Check Add digital signature to outgoing messages on the Security tab of the Options 
dialog box. 

To sign a specific email message: 

1. On the Outlook toolbar, click Options. The Message Options dialog box appears.  
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2. Check Add digital signature to outgoing message, and click Close. 

3. Click Send to send the message.  

Receiving Signed Email Messages 

Using Outlook, you can validate the authenticity of any signed email message you receive. 
This assures you that the message is indeed from the stated sender and that the message has not 
been tampered with since it was sent.  

When you receive a signed email message, Outlook displays one of the following icons in the 
message window: 

 
The digital signature is valid. Click this icon to view the signature’s details. 

 
The digital signature is invalid. Click this icon to view the reason(s) this 
signature is invalid. 

You may also see the  icon to the left of the message in the inbox. This icon indicates that 
the sender checked the Send clear text signed message option (refer to Figure 102). 
 

Note: To properly validate the certificate of the sender, install the ROOT CA certificate of the 
sender’s organization. For information on installing the ROOT CA certificate, refer to 
Installing the ROOT Certificate. 

Note: If you are using Microsoft Web Mail of Microsoft Exchange 2000, you cannot view the 
content of the signed email you receive. However, you can view the content of a signed email 
in Web Mail of Microsoft Exchange 2003. 

Note: In some versions of Outlook (for example, Outlook XP), Outlook attempts to validate 
that the signer’s certificate has not been revoked. To do this, Outlook attempts to connect to 
the Active Directory through the network and download a CRL (via LDAP or HTTP protocol). 
This network activity may be time consuming or blocked by firewalls. 

Installing the ROOT Certificate 

For information on installing the ROOT certificate, refer to Installing the ROOT Certificate. 

Signing Outlook Express Emails 

Microsoft Outlook Express includes tools for sending and receiving digitally signed emails. 
CoSign integrates with Outlook Express by managing your public and private keys and 
certificates. This enables you to easily sign emails in Outlook Express. 

Before sending signed email messages using Outlook Express, you must configure Outlook 
Express to associate your certificate with your email account. 
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Configuring Outlook Express 

To configure Outlook Express: 

1. Open Outlook Express. 

2. Open the Tools menu and select Accounts. The Internet Accounts dialog box appears. 

3. Select the Mail tab.  

 

Figure 104  Internet Accounts – Mail 

4. Select the email account with which you want to use your certificate, and click Properties. 
The Account Properties dialog box appears. 
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5. Select the Security tab.  

 

Figure 105  Account Properties – Security 

6. In the Signing certificate section of the dialog box, click Select. The Select Default 
Account Digital ID dialog box appears.  

7. Select the certificate you want to use, and click OK.  
 

Note: Only certificates with the same email address as the selected account are displayed. 

Sending Signed Email Messages 

To sign all your email messages: 

1. In Outlook Express, open the Tools menu and select Options. The Options dialog box 
appears. 

2. Select the Security tab. 
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Figure 106  Options – Security 

3. Check Digitally sign all outgoing messages, and click OK. 

To sign a specific email message: 

1. On the New Message toolbar, click . 

2. Click Send to send the message. 

Receiving Signed Email Messages  

You can validate the authenticity of any signed email message you receive. This assures you 
that the message is indeed from the stated sender and that the message has not been tampered 
with since it was sent.  

When you receive a signed email, the email includes a signed email icon . If the signature 
is invalid for any reason, Outlook Express displays a security warning indicating the problem. 

Distributing the ROOT Certificate 

For information on installing the ROOT certificate, refer to Installing the ROOT Certificate. 
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Chapter 10: CoSign Configuration Utility 

The CoSign client behavior in general and each CoSign component in particular have several 
modes of operation that are suitable for different kinds of usage and customer needs. These 
different modes of operation can be set by the user, or can be set and then distributed by the 
organization’s administrator. 

The CoSign Configuration Utility enables both the user and the administrator to set the 
configuration of any parameter in any of the CoSign client components both for a single 
machine and for a group of machines. 

All administrator related functionality is described in the CoSign Administrator Guide. 

Overview 

The CoSign Configuration Utility is a GUI application that enables a user or administrator to 
set any of the CoSign client components’ configurable parameters easily and intuitively. 

The CoSign configuration Utility can run in either of two modes:  

♦ Admin mode – Run by an administrator to build a certain setting for distribution. It can be 
a registry file or a group policy that can be distributed to different clients by the Active 
Directory group policy mechanism, using login scripts or manually. 

♦ End User mode – Enables a user (or administrator) to view or configure the CoSign client 
behavior on the machine on which the utility is running. 

The utility displays a components tree, in which you can select the component whose 
configuration values you wish to set. Each component includes several independent groups of 
parameters, which can be independently set. 

The utility can also be used on a specific machine to view or update the current configuration. 
This may be useful for debugging purposes or when the client behavior deviates from the 
expected. 
 

 
Note: The CoSign Configuration utility is not the only method for changing the CoSign 
client’s behavior. Some of the components have their own GUI for setting their own 
configuration (such as the ARX Legacy Word Add-in plug-in, OmniSign, and others), but 
while the components' GUI changes the setting of the current user, the CoSign 
Configuration utility changes the configuration of the local machine. 

You can also use the CoSign Configuration Utility to retrieve the CoSign internal CA 
certificate and the CoSign CA CRL (Certificate Revocation List). 
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Using the CoSign Configuration Utility 

The CoSign Configuration Utility enables you to view and edit all the configurable parameters 
of the CoSign client components. In End User mode, only the installed components are 
displayed. Refer to Running the CoSign Configuration Utility in End User Mode, for more 
information.  

To run the CoSign Configuration Utility: 

1. Select Start > Programs > ARX CoSign > CoSign Control Panel. The CoSign Control 
panel appears. Select Client Configuration. The CoSign configuration utility’s main 
window appears. 

 

Figure 107  CoSign Configuration Utility – Main Window  

The left pane of the CoSign Configuration Utility displays a components tree. Each node in the 
highest level of the tree is a configurable client component. Each component has one or more 
sub-nodes, with each sub-node being a group of parameters. These sub-nodes group 
parameters by category, except for the Miscellaneous sub-node, which includes all the 
parameters that are not included in any of the other groups. 

To edit a parameter:  

1. Double-click the component to which this parameter belongs, or click  to the left of the 
component. The component’s sub-nodes are displayed (refer to Figure 108). 
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2. Select the sub-node that contains the parameter. The right pane displays all the 
configurable parameters for the sub-node (refer to Figure 108 for an example). 

The right pane of each sub-node (except Miscellaneous) displays all the configurable 
parameters, with a triplet of radio buttons on top. Since the Miscellaneous group is a 
collection of various unrelated parameters, it may display several triplets, one for each logical 
set of parameters. 

 

Figure 108  Configurable Parameters of a Sub-node 

3. Select one of the radio button options: 

♦ Not Configured – When this option is selected, the local machine definition of this 
sub-node’s parameters remains unchanged when the configuration is applied to the 
local machine.  
When this option is selected, the parameters are disabled. 

♦ Use Defaults – When this option is selected, registry entries for all this sub-node’s 
parameters are removed when the configuration is applied to the local machine, and 
the CoSign defaults are used.  
When this option is selected, the parameters are disabled. 

♦ Set <Sub-node Name> Parameters – When this option is selected, the sub-node’s 
parameters become editable and display values where applicable (either the default 
value or a value taken from the local machine definition). When the configuration is 
applied to the local machine, all the parameters of this group are written to the 
registry. New registry keys and values will be created if necessary, and the old values, 
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if defined, are overwritten. 
 
Refer to the following sections for explanations of the parameters of the following 
configurable CoSign components: 

♦ Setting Client Configuration. 

♦ Setting Signature API Configuration. 

♦ Setting Microsoft Office Configuration. 

♦ Setting OmniSign Configuration. 

 
Note: Starting from CoSign version 4.4, the name of the section is displayed in bold 
if any modifications were made to the default values. 

CoSign Configuration Utility Menus 

♦ The following sections describe the menu options available from the CoSign 
Configuration Utility: File, CA, and Help. Note that the File menu differs for Admin mode 
and End User mode. 

File Menu – End User Mode 
The following options are available in End User mode from the File drop-down menu: 

♦ Export to configuration file – Enables exporting the local machine settings to a 
configuration file. Browse for the desired file name and location. Refer to the CoSign 
Configuration Utility chapter in the CoSign Administrator Guide. 

♦ Import configuration file – Enables importing settings from a configuration file. Browse 
for the desired file name and location. Refer to the CoSign Configuration Utility chapter in 
the CoSign Administrator Guide. 

♦ Apply (Save to Registry) – Enables changing the machine’s configuration as per the 
changes performed using the CoSign Configuration Utility, by applying the changes to the 
registry. Refer to Applying the Changes to the Local Registry. 

♦ Load (From Registry) – Enables clearing all current values in the application dialogs and 
replacing them with the registry values. Refer to Reloading the Registry Configuration. 

CA Menu 
The following options are available from the CA drop-down menu: 

♦ Install CoSign CA Certificate – Enables installing CoSign’s ROOT certificate into the 
current user’s PC. Refer to Chapter 2: Deploying the CoSign Client for information 
relating to CoSign’s ROOT certificate. 

♦ Download CoSign CA Certificate – This option is very similar to the Install CoSign CA 
Certificate option. The difference is that in this case the CoSign ROOT CA certificate is 
output to a selected file. The downloaded file can be placed in the AIA location according 
to the AIA field defined in the users’ certificates. 
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♦ Download CoSign CA CRL – Enables downloading the CoSign CRL (Certificate 
Revocation List) to a file. The downloaded file can be placed in the CDP (CRL 
Distribution Point) location according to the CDP field defined in the users’ certificates. 

Help Menu 

The following options are available from the Help drop-down menu: 

♦ About – Displays the version of the CoSign configuration utility as well as a link to the 
ARX web site. 

♦ Contents – Displays the content of this chapter in on-line help format. 

♦ Create report – Enables generating a report listing information on both the CoSign Client 
installation and the CoSign appliance installation. Click Save to save the report to a file. 
The file can be sent to ARX support for problem analysis. 

The report includes three parts: 

♦ CoSign Client installation files – Includes all the files of the CoSign installation, their 
dates, sizes and version information. 

♦ CoSign Client and Server parameters – Includes CoSign Client and Server parameters. 
The parameters also include information that is displayed in the CoSign console. 

♦ Environmental information – Displays information about the PC in which the CoSign 
client is installed, the version of the installed MS Office application, and other 
parameters that can be valuable to ARX support for problem analysis. 

Running the CoSign Configuration Utility in End User Mode 

The CoSign Configuration Utility can also be used for editing and viewing a specific machine’s 
settings. When the application runs in End User mode, it looks for all the CoSign components that 
are installed, and for each component reads its settings and displays them in the relevant dialog. 

To run the CoSign Configuration Utility in End User mode: 

1. Select Start > Programs > ARX CoSign > CoSign Control Panel. The CoSign Control 
panel appears. Select Client Configuration. The CoSign configuration utility’s main 
window appears. 

In End User mode, the information in the right pane reflects the state of the CoSign client 
parameters in the registry. For each group of parameters, the Use Defaults option is selected if 
none of this group’s values were set in the registry, and the fields are greyed out. If some of the 
group’s values were set in the registry, the Set <Sub-node Name> Parameters option is 
selected. After editing the parameters’ values, the changes must be applied in order to update 
the registry. These actions are described below. 

 
Note: To change settings in End User Mode, the current user must have the appropriate 
permissions to change registry values under HKEY_LOCAL_MACHINE. 
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After the CoSign Configuration Utility is up and running, you can view and edit all the 
settings, or you can import additional settings from a configuration file and then edit all 
settings. When editing is complete, you can either apply the changes to the local machine's 
registry or export them to a configuration file. 

Following is the list of actions that can be performed in End User mode: 

♦ Viewing and Editing CoSign Client Settings. 

♦ Applying the Changes to the Local Registry. 

♦ Reloading the Registry Configuration. 

♦ Installing and downloading the CoSign CA certificate (refer to Install CoSign CA 
Certificate and Download CoSign CA Certificate). 

♦ Downloading the CoSign CA CRL (Certificate Revocation List) (refer to Download 
CoSign CA CRL). 

Viewing and Editing CoSign Client Settings 

To view and edit the CoSign Client Settings, follow the instructions in Using the CoSign 
Configuration Utility. 

Changing CoSign client values using the CoSign Configuration Utility does not automatically 
change the machine's configuration. They must be explicitly applied in order to take effect 
(refer to Applying the Changes to the Local Registry). 

Applying the Changes to the Local Registry 

Changes performed using the CoSign Configuration Utility do not automatically change the 
machine's configuration. They must be explicitly applied to the registry in order to take effect. 
Select File > Apply (save to registry) to apply all changes to the local machine settings. 
If you close the application without specifying Apply (save to registry), you will lose all the 
changes you have made. 
 

 
Note: If you would like to restore default values after applying changes to the registry, do 
not use the Not Configured option. Instead, use the Use Defaults option which enforces 
resetting of the parameters back to the default values. 

Reloading the Registry Configuration 

If you are not satisfied with the changes you made to the configuration, and have not yet saved 
them to the registry, or if the local setting was changed outside the application and you want to 
reload the current setting from the registry, select File > load (from registry) to clear all 
current values in the application dialogs and replace them with the registry values. 
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Setting Client Configuration 

The client configuration contains parameters related to connectivity and authentication with 
CoSign. The CoSign client is the basic CoSign component, therefore all CoSign-enabled 
applications are affected by the client’s settings.  

Client configuration is composed of the following groups: 

♦ Appliances – In this group you can manually define the addresses of the CoSign 
appliances and their authentication mechanism. 

♦ Login dialog – In this group you can set all the parameters relating to the login dialog for 
the environments in which such a dialog pops up. 

♦ Timeouts – In this group you can set the various timeouts relating to communication 
between the CoSign client and the CoSign appliance. 

♦ Miscellaneous – In this group you can set logging parameters and other miscellaneous 
parameters. 

Client – Appliances 

This group enables you to manually set the IP address or DNS name of the CoSign appliances 
the machine should work with, usually in Directory Independent environments, and whether to 
pop up a logon dialog and signing dialog. 

 

Figure 109  Configuring Client – Appliances Parameters 



10 CoSign User Guide 

142 

In the Appliances group you can set the following CoSign client parameters: 

♦ SSL Proxy definitions – If the CoSign client can connect to the CoSign appliance only 
through an SSL proxy, provide the SSL proxy parameters to enable communications. 
Specify the following: 

♦ Enable automatic ssl proxy detection – If this parameter is checked, the CoSign 
client will use the local PC definitions of the SSL proxy. In this case other SSL proxy 
parameters are disabled. 

♦ SSL Proxy address – The DNS name or IP address of the SSL Proxy. 

♦ port – The TCP/IP port number of the SSL proxy. 

♦ Prompt for logon method – Select one of the following values if you wish to enforce a 
specific logon method that is different from the one defined in CoSign: 

♦ Auto (default) – The value is chosen automatically according to system setup. 

♦ SSPI – Enable login through Single-Sign-On mode (relevant for Active Directory 
environments).  

♦ User Pwd Server Side (AD/NDS/LDAP) – The user and password are passed to the 
server for verification and the authentication check is performed by the CoSign 
appliance. This option is relevant for Active Directory, Novell NDS, and LDAP 
environments. 

♦ SSPI User Pwd Client Side (AD) – The user is requested to input the user name and 
password, which will be verified by the CoSign client. This option is relevant only for 
Microsoft Active Directory environments. 

♦ Directory Independent Prompt – The user password mechanism used in Directory 
Independent environments. 

♦ Prompt for sign method – Select one of the following values if you wish to enforce a 
specific authentication method that is different from the one defined in CoSign: 

♦ Auto (default) – The value is chosen automatically according to system setup. 

♦ None – No prompt appears upon digital signature operation. 

♦ User Pwd Server Side (AD/NDS/LDAP) – The user name and password are passed to 
the server for verification. This option is relevant for Active Directory, Novell NDS, 
and LDAP environments. 

♦ Directory Independent Prompt – The user password mechanism used in Directory 
Independent environments. 

♦ Directory type – Specify the directory used for synchronizing the CoSign users: 

♦ Auto (default) – The directory type is taken from the CoSign server. 

♦ AD – The CoSign users are defined in Active Directory. 

♦ NDS – The CoSign users are defined in Novell's Directory. 

♦ LDAP – The CoSign users are defined in an LDAP Directory. 
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♦ Directory Independent – The CoSign users are not automatically synchronized with 
any directory. 

 
Note: The directory type influences the automatic behavior of prompt for 
logon method and prompt for sign method. 

♦ Preferred  Server – If this field is not empty, the CoSign client will first attempt to 
connect to this CoSign appliance. The Preferred server must be listed either in the SCP 
CoSign servers list or in the following Appliances List. 

♦ Appliances list – Enter the list of all available CoSign appliances. If more than one 
appliance is added, the CoSign client performs load balancing between them. Use the Add 
and Remove buttons to edit the list. You can specify a CoSign appliance by either its IP 
address or its DNS name. 

Client – Login Dialog 

This group enables you to control the login dialog behavior. 

 

Figure 110  Configuring Client – Login Parameters 

In the Login group you can set the following CoSign client parameters: 

♦ Verify user name in prompt for sign – If this value is checked, the user has to provide 
both the user name and password if prompt for sign is set. Otherwise, the user name is 
provided automatically by the Prompt for Sign dialog. 
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♦ Force upper case user name – Change this value only if instructed to do so by ARX 
support. 

♦ Close dialog when inactive for <number> Sec. – Determines the time of inactivity the 
login dialog waits before automatically closing itself.  

 
Note: If the login dialog closes itself, the logon operation fails. 

♦ Permit login dialog pop-up except for designated applications – Select this option to 
enable all applications to pop up the login dialog except for the applications listed in the 
Exceptional applications field. 

♦ Deny login dialog pop-up except for designated applications – Select this option to 
prevent all applications from popping up the login dialog except for the applications listed 
in the Exceptional applications field. 

 
Note: The previous two options are relevant only in environments where a login 
dialog should pop up before working with CoSign. 

♦ Disable login dialog – Prevent all applications from popping up the login dialog. If this 
option is selected and an application tries to pop up the login dialog, the operation will fail, 
and no dialog is displayed. This option should be used for unattended environments. 

♦ Designated applications – A list of applications referenced by the options Permit login 
dialog pop-up except for designated applications and Deny login dialog pop-up 
except for designated applications. Use the Add and Remove buttons for editing this 
list. 

Client – Timeouts 

This group enables you to set the various timeouts relating to communication between the 
CoSign client and the CoSign appliance.  

 
Note: Do not change the timeouts parameters unless instructed to do so by ARX technical 
support. Incorrect values might prevent the user from succeeding in connecting the CoSign 
appliance. 
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Figure 111  Configuring Client – Timeouts Parameters 

Client – Miscellaneous 

This group enables you to set the logging parameters of the CoSign client and other 
miscellaneous parameters. These logging parameters affect only the layer of communication 
between the client and the CoSign appliance, and do not affect any other client components. 
To set the logging parameters of a specific component, configure the logging parameters in the 
Miscellaneous sub-node of that component. 
 

 
Note: Changing the logging parameters can extensively degrade the performance of the 
client. It is therefore recommended not to change the logging parameters unless instructed 
to do so by ARX technical support. 
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Figure 112  Configuring Client – Miscellaneous Parameters 

In the Miscellaneous group you can set the following CoSign client parameters: 

♦ Detail level – The reporting level to the log. 

♦ File name – The path for the CoSign client log file. 

♦ Domain – Do not set this parameter unless instructed to do so by ARX technical support. 

♦ SSCD – In this section you can setup client parameters if the CoSign appliance hardware 
is CoSign SSCD. 

♦ Place Manually generated keys on SSCD – If this option is set, any newly generated 
key (usually through enrollment to an external CA) will be placed inside the SSCD 
device. If this option is not set, the newly generated key will be placed and encrypted 
in the CoSign Appliance’s internal database. 

♦ Disable automatic enrollment – If this option is set, the enrollment for the user’s first 
SSCD key can be activated only through the CoSign control panel. 
If this option is not set, any application that connects to CoSign, such as Microsoft 
Word, can trigger the enrollment of the new CoSign key. 
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Setting Signature API Configuration 

SAPI is a programming interfacing component used by CoSign and by software developers to 
interface with CoSign. The SAPI (Signature API) configuration enables you to define time 
stamping parameters and graphical image parameters, as well as logging parameters related to 
SAPI operations.  

Signature API – Time Stamp 

This group enables you to define time stamp server parameters so that every digital signature 
will include a time stamp. These parameters are relevant to any SAPI based application, 
including OmniSign and the Legacy Office add-in. 

 
Figure 113  Configuring Signature API – Time Stamp Parameters 

In the Time stamp group you can set the following Signature API parameters: 

♦ Use time stamp in signatures – If this option is selected, a time stamp is used for every 
generated digital signature. 

♦ Time stamp size – The size of the place holder for the time stamp information. Do not 
change this value without consulting with ARX. 

♦ Time stamp URL – The HTTP or HTTPS location of the time stamp server. 

♦ User name – The user name of a user who is authorized to use the time stamp server. 

♦ User’s password – The password of the authorized user. 
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Signature API – Graphical Images 

This group enables you to define settings for using graphical images through the SAPI 
applications. 

 
Figure 114  Configuring Signature API – Graphical Images Parameters 

In the Graphical Images group you can set the following Signature API parameters: 

♦ Capturing device ID – Specify the mechanism or device to be used by the ARX graphical 
signature application to upload a graphical image to CoSign: 

♦ Automatic – The currently installed capture device is the device used to enter the 
graphical image. In this mode, if no capture device is installed, the graphical signature 
will be captured from a Tablet-PC or a Mouse. 

♦ Manual – The user can select the capturing mechanism directly from the graphical 
signature application. 

♦ Extended – Do not use this option. 

♦ Topaz SigLite – The Topaz SigLite device is used. 

♦ Interlink ePad – The Interlink ePad device is used. 

♦ Tablet PC / Mouse – Either a Tablet-PC or a Mouse is used to enter a graphical image. 

♦ Script Font – A script font is used to enter a specially formatted graphical image. 
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♦ Default capturing font name – If a script font is used to enter the graphical image, you . 
can specify the default script font. 

♦ PDF image type – This option is relevant for the Update Acrobat operation in the 
Graphical Signatures Utility that imports graphical images into Adobe Acrobat 6/7/8 and 
Adobe Reader 6/7/8. You can select one of the following options: 

♦ Bit map (bmp) image – The graphical image is stored in the document as a bitmap. 

♦ Line vectors – The vectorial representation of the graphical image is stored in the 
document. 

Signature API – Miscellaneous 

This group enables you to set the logging parameters of the SAPI lib.  
 

 
Note: Changing the logging parameters can extensively degrade the performance of the 
client. It is therefore recommended not to change the logging parameters unless instructed 
to do so by ARX technical support. 

 

Figure 115  Configuring Signature API – Miscellaneous Parameters 

In the Miscellaneous group you can set the following Signature API parameters: 

♦ Detail level – The reporting level to the log. 

♦ File name – The path for the SAPI log file. 
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Setting Microsoft Office Configuration 

The Microsoft Office configuration enables you to set the default behavior of the signing 
operation in Word, Excel, and InfoPath. This includes the signature appearance, the signing 
method, which data will be signed, and a list of available reasons for signing and logging. 

Microsoft Office configuration also enables you to configure parameters that may be 
applicable for the ARX Signature Line Provider for Office 2007 as well as for the ARX 
Legacy Word Add-in for Word/Excel 2000/XP/2003. 

The Microsoft Office configuration is composed of the following groups: 

♦ Appearance – In this group you can configure the default appearance of a signed 
signature field. 

♦ Settings – In this group you can set parameters relating to the signing method, algorithms, 
and the data to sign. 

♦ Reasons – In this group you can edit the list of reasons that can be attached to a signed 
signature field. 

♦ Excel Specific – In this group you can configure the content and scope of data that will be 
signed in Excel. 

♦ Word Specific – In this group you can configure the content and scope of data that will be 
signed in Word. 

♦ Miscellaneous – In this group you can set the Office logging parameters, indicate whether 
to check CRLs, and indicate whether to enforce the local machine settings over the local 
user settings. 

For more information on using CoSign to sign Word and Excel documents, refer to Chapter 3: 
Signing Microsoft Office Documents. For more information on using InfoPath, refer to Chapter 
4: Signing InfoPath Forms. 
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Microsoft Office – Appearance 

This group enables you to set the default appearance of a signed signature field, including the 
fields to be displayed, the size, and the time format. 

 

Figure 116  Configuring Microsoft Office – Appearance Parameters 

In the Appearance group you can set the following Microsoft Office parameters: 

♦ Display validation mark (V) – Check the On Screen option and/or the In Print option to 
specify that the document on screen and/or the printed document will include this symbol 
if the signature is valid. 
This option is relevant only for the ARX Legacy Word Add-in for Office 2000/XP/2003. 

♦ Display invalidation mark (X) – Check the On Screen option and/or the In Print option 
to specify that the document on screen and/or the printed document will include this 
symbol if the signature is invalid. 
This option is relevant only for the ARX Legacy Word Add-in for Office 2000/XP/2003. 

♦ Display unknown status mark (?) – Check the On Screen option and/or the In Print 
option to specify that the document on screen and/or the printed document will include this 
symbol if the status of the signature is unknown. 
This option is relevant only for the ARX Legacy Word Add-in for Office 2000/XP/2003. 

♦ Display GMT offset – Specify whether the GMT offset will be displayed. 
This option is relevant for both the ARX Legacy Word Add-in for Office 2000/XP/2003 
and for the ARX Signature Line provider. 
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♦ Time format – Specify the displayed time format. 
This option is relevant for both the ARX Legacy Word Add-in for Office 2000/XP/2003 
and for the ARX Signature Line provider. 

♦ Date format – Specify the displayed date format. 
This option is relevant for both the ARX Legacy Word Add-in for Office 2000/XP/2003 
and for the ARX Signature Line provider. 

 
Note: Display GMT offset, Time format, and Date format are relevant only if 
the Date and Time field is displayed in the signed signature field. 

♦ Width (pixels) – The width of the digital signature field in pixels. 
This option is relevant only for the ARX Legacy Word Add-in for Office 2000/XP/2003. 

♦ Height (pixels) – The height of the digital signature field in pixels. 
This option is relevant only for the ARX Legacy Word Add-in for Office 2000/XP/2003. 

♦ Appearance style – The format of the display of items inside the graphical signature 
image.  
This option is relevant only for the ARX Legacy Word Add-in for Office 2000/XP/2003. 
There are two available options: 

♦ Fixed font size – All text fields in the image are displayed in the same font size. This 
size is determined by the size of the image. 
This is the default option. 

♦ Variable font size – The font size of the various text fields is not fixed. This was the 
default option in previous versions.  

♦ Display date and time caption – Determines whether the title field Date and Time is 
displayed before the actual date and time field. 
This option is relevant only for the ARX Legacy Word Add-in for Office 2000/XP/2003. 

♦ Display reason caption – Determines whether the title field Reason is displayed before 
the actual reason field. 
This option is relevant only for the ARX Legacy Word Add-in for Office 2000/XP/2003. 

♦ Display signed by caption – Determines whether the title field Signed By is displayed 
before the actual signer field. 
This option is relevant only for the ARX Legacy Word Add-in for Office 2000/XP/2003. 

♦ Show these fields in this order – Specify which fields are displayed in the signed 
signature field, and in what order. Use the Add and Remove buttons to move fields 
to/from the Available fields box. Use the Move Down and Move Up buttons to change the 
order of the fields. 
This option is relevant for both the ARX Legacy Word Add-in for Office 2000/XP/2003 
and for the ARX Signature Line provider for Office 2007. However, the order of the fields 
is relevant only for the ARX Legacy Word Add-in for Office 2000/XP/2003. 
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Microsoft Office – Settings 

This group enables you to set the signing mechanism and algorithm as well as the data to be 
signed. 

 

Figure 117  Configuring Microsoft Office – Settings Parameters 

In the Settings group you can set the following Microsoft Office parameters: 

♦ Create Word compatible signatures – Select this option to generate a digital signature 
that can be validated in Word XP, Word 2003, and Word 2007 without the ARX Legacy 
Word Add-in plug-in (refer to Validating Graphical Signatures in Word documents 
Without Using the ARX Legacy Word Add-in Plug-in). 
This option is not relevant to ARX Signature Line provider. 

♦ Dependent signatures – Select this option to specify that all newly created digital 
signatures be dependent. 
This option is not relevant to ARX Signature Line provider. 

♦ Enable automatic verification – Select this option to direct MS Word or MS Excel to 
automatically verify all digital signatures of a document upon opening an existing 
document. 
This option is not relevant to ARX Signature Line provider. 

♦ Display Signature Setting Dialog for Office2007 – Use this option to direct the ARX 
Signature Line Provider for Office 2007 to display to the user the Signature Setting dialog 
upon field creation. 
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♦ Instructions to Office 2007 Signer – Use this option to specify the text that will be 
displayed to the user in the signature form during signature operation.  
This option is relevant to the ARX Signature Line provider. 

♦ Hash method – Do not modify this field. 
This option is not relevant to the ARX Signature Line provider. 

♦ Signature can be clear by – Specify the default policy for clearing signatures when using 
the ARX legacy office add-in. The options include: 

♦ Anyone – Anyone can clear a signed field. 

♦ No one – No one can clear a signed field. 

♦ Signer only – Only the signer can clear a signed field. 

Microsoft Office – Reasons 

This group enables you to build and edit the list of available reasons for signing, as well as to 
select one of them as the default reason. 

This window is relevant for both the ARX Legacy Word Add-in for Office 2000/XP/2003 and 
for the ARX Signature Line provider for Office 2007. 

 

Figure 118  Configuring Microsoft Office – Reasons Parameters 
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In the Reasons group you can set the following Microsoft Office parameters: 

♦ Enter reason for signature in Office 2007 – If you select this option, then the digital 
signature form is displayed for every signature operation, and the user is requested to add a 
reason for the digital signature operation. 

♦ Reasons – The list of reasons displayed for the user when a signature field is signed. You 
can enter a new reason and click Add to add it, or select a reason and click Remove to 
remove it from the list. 

♦ Default reason – The default reason displayed to the user when signing a signature field. 
The user can either click OK to sign with this reason, or select another reason and then 
continue with the signing operation. To specify the default reason, you can either edit a 
reason in this field or select one from the Reasons list and click Set as default. 

Microsoft Office – Excel Specific 

These options are relevant only to the ARX Legacy Word Add-in plug-in for 
Win2000/XP/2003. 

This group enables you to set the default content and scope of the data to be signed when 
performing a digital signature in Excel. 

 

Figure 119  Configuring Microsoft Office – Excel Specific Parameters 

In the Excel-specific group you can set the following Microsoft Office parameters: 

♦ Cell value – Check this option to include the value of the cells in the data to be signed. 
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♦ Cell formula – Check this option to include the formula of the cells in the data to be 
signed. 

 
Note: You must set either Cell value or Cell formula or both. 

♦ Cell properties – Check this option to include the properties of the cells in the data to be 
signed. 

♦ Scope – Indicates the scope of the data to be signed. You can select one of the following 
values: 

♦ Active Sheet – Only the data in the active sheet will be signed. 

♦ Workbook – All data in the workbook will be signed. 

♦ Selection – Only the data in a specific selection of cells will be signed. 

Microsoft Office – Word Specific 

These options are relevant only to the ARX Legacy Word Add-in plug-in for 
Win2000/XP/2003. 

This group enables you to set the default content and scope of the data to be signed when 
performing a digital signature in Word. 

 

Figure 120  Configuring Microsoft Office – Word Specific Parameters 
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In the Word-specific group you can set the following parameters: 

♦ In addition to text, signature applies to location & size of tables and objects – Check 
this option to include in the signature the values of the location and size of tables and 
objects. This option is relevant only for content-based signatures. 

♦ Field codes – Check this option to include in the signature the values of field codes. These 
are text fields that are updated automatically, such as Date or Header/Footer information. 

♦ Form Fields & Content Controls – Check this option to include in the digital signature 
information from Form Fields Content control. 

♦ Scope – Indicates the scope of the data to be signed. You can select one of the following 
values: 

♦ Entire File – The entire content of the Word file will be signed. 

♦ Document Content – All the textual and visible content of the Word document will 
be signed. 

♦ Selection – All the textual content of the current selection will be signed. 

Microsoft Office – Miscellaneous 

This group enables you to set the logging parameters, the CRL checking flag and to enforce 
centralized management of all the MS Office settings. 

 

Figure 121  Configuring Microsoft Office – Miscellaneous Parameters 
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In the Miscellaneous group you can set the following Microsoft Office parameters: 

♦ Set log parameters – You can set the following logging parameters: 

♦ Detail level – The reporting level to the log.  

♦ File name – The path for the Microsoft Office log file. 
 

 
Note: Changing the logging parameters can extensively degrade the 
performance of the client. It is therefore recommended not to change the 
logging parameters unless instructed to do so by ARX technical support. 

♦ Check CRL – You can set the following CRL (Certificate Revocation List) parameters: 

♦ Check the CRL – Determines whether to check the CRL when verifying a digital 
signature. 

♦ Local user settings – You can set the following local user settings: 

♦ Enable local user settings – Determines whether to enable a user to set his/her own 
settings through any of the supported Microsoft Office applications’ GUI. If this 
option is not checked, the configuration settings are always taken from the local 
machine. 

 
Note: If a user sets his/her own settings, an attempt to distribute a centralized 
managed setting will not succeed, and the user will keep using his/her own 
configuration. 
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Setting OmniSign Configuration 

OmniSign enables you to print and sign any document of any format. It includes both a special 
printer that converts the file to PDF, and an application that signs the PDF file. OmniSign 
configuration enables you to set parameters related to the signing application but not to the 
printing operation. 

OmniSign configuration is composed of the following groups: 

♦ Profiles – In this group you can set the appearance and location of the signature, which 
application to run after signing, where to save the signed file, and whether to run in silent 
mode. 

♦ Miscellaneous – In this group you can set logging parameters. 

For more information on using OmniSign, refer to Chapter 6: OmniSign – Sign Any Printable 
Data, Anywhere. 

OmniSign – Profiles 

This group enables you to set the parameters of the standard OmniSign profile (currently this is 
the only profile supported). The profile parameters affect the signature appearance, its location, 
which application to run after signing, where to save the signed file, and whether to run in 
silent mode. 

 
Figure 122  Configuring OmniSign – Profiles Parameters 
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In the Profiles group you can set the following OmniSign parameters: 

♦ Show instruction dialog – Specify whether to display instructions for using OmniSign 
whenever the application starts. 

♦ Run in silent mode – Specify whether to run OmniSign in silent mode. When running in 
silent mode, OmniSign has no interface to the user and all the relevant parameters must be 
set in advance, either via the CoSign Configuration Utility or via ARX OmniSign Setup. 

♦ Profiles list – A list of pre-configured profiles. Currently only the standard profile can be 
edited. Click Edit to edit the settings of the standard profile. The Edit OmniSign Profile 
dialog box appears (Figure 123), with the following tabs:  

♦ General – This tab cannot be edited in the OmniSign application itself, and is 
described below (refer to Editing a Profile’s General Settings). 

♦ Signature – This tab is described below (refer to Editing a Profile’s Signature 
Settings). There are some parameters that can be set only through OmniSign. These 
parameters are explained below and in Configuring the Signature Settings. 

♦ Advanced – For explanations refer to Configuring the Save Options. 

♦ Reasons - This tab cannot be edited in the OmniSign application itself, and is 
described below (refer to Editing a Profile’s General Settings) 

Editing a Profile’s General Settings 

The General tab enables you to set the parameters affecting the zoom value, graphical image 
format, signature appearance, and color of the signature rectangle. 



Using the CoSign Configuration Utility 10 

 161 

 

Figure 123  Configuring OmniSign – General Profile Parameters 

In the General tab of the Profile group you can set the following OmniSign parameters:  

♦ Initial zoom – The zoom value to be used when opening the document in the preview 
pane. 

♦ Signing Flags – You can set the following parameters: 

♦ Image type – Specify the graphical image format. You can select one of the following 
options: 

♦ Bit map (bmp) image – The graphical image is stored in the document as a bitmap. 

♦ Line vector – The vectorial representation of the graphical image is stored in the 
document. 

♦ Signature orientation – Specify how to organize the fields in the signature 
appearance. You can select one of the following options: 
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♦ Vertical split – The graphical image or signer’s name appears in the left half of 
the signature field, and the rest of the fields appear in the right half. 

♦ Horizontal split – The graphical image or signer’s name appears in the top half of 
the signature field, and the rest of the fields appear at the bottom. 

♦ Region color – Specify the RGB values of the rectangle which indicates the location and 
size of the signature: 

♦ Red – Specify a value between 0 and 255 for the red color in the rectangle’s color. 

♦ Green – Specify a value between 0 and 255 for the green color in the rectangle’s 
color. 

♦ Blue – Specify a value between 0 and 255 for the blue color in the rectangle’s color. 

♦ Select color – You can use this button to select a color from a color palette. The 
values in the Red, Green and Blue fields are automatically updated. 

Editing a Profile’s Signature Settings 

This tab enables you to set the signature settings in OmniSign. 
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Figure 124  Configuring OmniSign – a Profile’s Signature Parameters 

In the Signature tab of the Profile group you can set the following OmniSign parameters:  

♦ Allow Electronic (Graphical) Signatures – Select this option if you wish to enable 
adding an electronic signature before adding a digital signature. 

♦ Signature List – Select from the list the default signature type to appear in OmniSign. 

The descriptions of the rest of the parameters appear in Configuring the Signature Settings. 

Editing a Profile’s Reasons Settings 

In the Reasons tab of the Profile group you can define the set of reasons that can be used by 
the OmniSign application.  

♦ Use Add to add a reason from the optional reasons box to the list of reasons. 

♦ Use Remove reason to remove a reason from the list of reasons. 
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♦ A reason will be used as default the next time OmniSign is executed if you enter that 
reason in the signature reason field or click Use This Reason. 

OmniSign – Miscellaneous 

This group enables you to set the logging parameters in OmniSign. 
 

 
Note: Changing the logging parameters can extensively degrade the performance of the 
client. It is therefore recommended not to change the logging parameters unless instructed 
to do so by ARX technical support. 

 

Figure 125  Configuring OmniSign – Miscellaneous Parameters 

In the Miscellaneous group you can set the following OmniSign parameters: 

♦ Log – You can set the following logging parameters: 

♦ Detail level – The reporting level to the log.  

♦ File name – The path for the OmniSign log file. 
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Chapter 11: Troubleshooting 

This chapter offers solutions to various problems you may encounter while installing or 
running CoSign. 

If you are unable to identify or solve a problem, contact ARX Support: 

ARX Support 
US Headquarters 
341 First Ave. South 
Pleasant Hill, 
CA 94523 
Tel: : (925) 798 0901 
Fax : (925) 226 1982 
Toll Free : (877) 999 6667 
Support : (866) EASY-PKI  

Canadian Office 
447 Mullen Dr. 
Thornhill, 
ON L4J 2N9 
Tel : (905) 763 2122 
Fax : (905) 763 6122 
Toll Free : (877) 754 3744 
Support : (877) PKI-E-SIG  

 
Email address: support@arx.com 
Web site: http://www.arx.com 

Client-Related Problems 

This section describes various problems and error messages you may encounter while running 
the CoSign Client, and provides possible solutions to these problems. 

Cannot Enable the “Add Digital Signature to Outgoing Messages” Checkbox in 
Outlook 

Problem: In Microsoft Outlook, the Add digital signature to outgoing messages checkbox 
is disabled. 

Solution: In order to send signed emails, you must first define security settings. Refer to 
Configuring Outlook. 

Cannot See Any Certificates in Store 

Problem: You cannot see any certificates in your Microsoft Personal certificates store. 

Solution: Perform the following: 

1. Restart the machine and try again. 

2. Verify the following: 

♦ You are logged in to the same domain as CoSign. You should not be logged in to any 
other domain, and you should not be logged in to the current machine. 

mailto:support@arx.com
http://www.arx.com/
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♦ Your DNS definitions are correctly configured on the PC. These definitions should be 
the same as the domain’s DNS. 

♦ You receive a response when you ping the CoSign IP address or try to connect to 
CoSign using telnet to port 443.  

♦ Your user account is defined in the directory that was defined as the AD users 
container during CoSign installation (refer to the chapter Managing the CoSign 
Installation in the CoSign Administrator Guide). 

♦ If you are using a Directory Independent environment, you did not omit to set 
configuration parameters for the client machine. Use the Cosign Configuration Utility 
to setup the CoSign appliance IP address (refer to Client – Appliances). 

Cannot Create a Digital Signature Field Using the ARX Legacy Add-in 

Problem: You cannot generate a signature field since Word or Excel cannot switch to Design 
Mode. 

Solution: Check the following: 

♦ Check whether the Visual Basic for applications component is installed. If it is not 
installed, install it from the Office installation CD. 

♦ Make sure the ARX plug-in is not disabled in Office applications: 
1. Select About... > Disabled Items in the Help menu of the Office application. 
2. If the ARX Signature add-in is listed, remove it from the list. 

♦ Check whether Enable Automatic Verification is unselected in the Settings tab of 
the Microsoft Office section of the CoSign Configuration Utility. If it is selected, 
deselect it. 
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